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Legal Notices
©1999-2003, Rational Software Corporation. All rights reserved.
Part Number: 800-026067-000
Version Number: 2003.06.00

This manual (the "Work") is protected under the copyright laws of the United States 
and/or other jurisdictions, as well as various international treaties. Any reproduction 
or distribution of the Work is expressly prohibited without the prior written consent 
of Rational Software Corporation.

The Work is furnished under a license and may be used or copied only in accordance 
with the terms of that license. Unless specifically allowed under the license, the Work 
or copies of it may not be provided or otherwise made available to any other person. 
No title to or ownership of the manual is transferred. Read the license agreement for 
complete terms.

Rational Software Corporation, Rational, Rational Suite, Rational Suite 
ContentStudio, Rational Apex, Rational Process Workbench, Rational Rose, Rational 
Summit, Rational Unified process, Rational Visual Test, AnalystStudio, ClearCase, 
ClearCase Attache, ClearCase MultiSite, ClearDDTS, ClearGuide, ClearQuest, 
PerformanceStudio, ProjectConsole, PureCoverage, Purify, Quantify, Requisite, 
RequisitePro, RUP, SiteCheck, SiteLoad, SoDa, TestFactory, TestFoundation, TestMate 
and TestStudio are registered trademarks of Rational Software Corporation in the 
United States and are trademarks or registered trademarks in other countries. The 
Rational logo, Connexis, ObjecTime, Rational Developer Network, RDN, 
ScriptAssure, and XDE, among others, are trademarks of Rational Software 
Corporation in the United States and/or in other countries. All other names are used 
for identification purposes only and are trademarks or registered trademarks of their 
respective companies.

Portions covered by U.S. Patent Nos. 5,193,180 and 5,335,344 and 5,535,329 and 
5,574,898 and 5,649,200 and 5,675,802 and 5,754,760 and 5,835,701 and 6,049,666 and 
6,126,329 and 6,167,534 and 6,206,584. Additional U.S. Patents and International 
Patents pending.

U.S. Government Restricted Rights
Licensee agrees that this software and/or documentation is delivered as "commercial 
computer software," a "commercial item," or as "restricted computer software," as 
those terms are defined in DFARS 252.227, DFARS 252.211, FAR 2.101, OR FAR 52.227, 
(or any successor provisions thereto), whichever is applicable. The use, duplication, 
and disclosure of the software and/or documentation shall be subject to the terms and 
conditions set forth in the applicable Rational Software Corporation license 
agreement as provided in DFARS 227.7202, subsection (c) of FAR 52.227-19, or FAR 
52.227-14, (or any successor provisions thereto), whichever is applicable.
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Warranty Disclaimer
This document and its associated software may be used as stated in the underlying 
license agreement. Except as explicitly stated otherwise in such license agreement, 
and except to the extent prohibited or limited by law from jurisdiction to jurisdiction, 
Rational Software Corporation expressly disclaims all other warranties, express or 
implied, with respect to the media and software product and its documentation, 
including without limitation, the warranties of merchantability, non-infringement, 
title or fitness for a particular purpose or arising from a course of dealing, usage or 
trade practice, and any warranty against interference with Licensee's quiet enjoyment 
of the product.

Third Party Notices, Code, Licenses, and Acknowledgements
Portions Copyright ©1992-1999, Summit Software Company. All rights reserved.

Microsoft, the Microsoft logo, Active Accessibility, Active Client, Active Desktop, 
Active Directory, ActiveMovie, Active Platform, ActiveStore, ActiveSync, ActiveX, 
Ask Maxwell, Authenticode, AutoSum, BackOffice, the BackOffice logo, bCentral, 
BizTalk, Bookshelf, ClearType, CodeView, DataTips, Developer Studio, Direct3D, 
DirectAnimation, DirectDraw, DirectInput, DirectX, DirectXJ, DoubleSpace, 
DriveSpace, FrontPage, Funstone, Genuine Microsoft Products logo, IntelliEye, the 
IntelliEye logo, IntelliMirror, IntelliSense, J/Direct, JScript, LineShare, Liquid Motion, 
Mapbase, MapManager, MapPoint, MapVision, Microsoft Agent logo, the Microsoft 
eMbedded Visual Tools logo, the Microsoft Internet Explorer logo, the Microsoft 
Office Compatible logo, Microsoft Press, the Microsoft Press logo, Microsoft 
QuickBasic, MS-DOS, MSDN, NetMeeting, NetShow, the Office logo, Outlook, 
PhotoDraw, PivotChart, PivotTable, PowerPoint, QuickAssembler, QuickShelf, 
RelayOne, Rushmore, SharePoint, SourceSafe, TipWizard, V-Chat, VideoFlash, Visual 
Basic, the Visual Basic logo, Visual C++, Visual C#, Visual FoxPro, Visual InterDev, 
Visual J++, Visual SourceSafe, Visual Studio, the Visual Studio logo, Vizact, WebBot, 
WebPIP, Win32, Win32s, Win64, Windows, the Windows CE logo, the Windows logo, 
Windows NT, the Windows Start logo, and XENIX, are either trademarks or registered 
trademarks of Microsoft Corporation in the United States and/or in other countries.

Sun, Sun Microsystems, the Sun Logo, Ultra, AnswerBook 2, medialib, OpenBoot, 
Solaris, Java, Java 3D, ShowMe TV, SunForum, SunVTS, SunFDDI, StarOffice, and 
SunPCi, among others, are trademarks or registered trademarks of Sun Microsystems, 
Inc. in the U.S. and other countries.

Purify is licensed under Sun Microsystems, Inc., U.S. Patent No. 5,404,499.

Licensee shall not incorporate any GLOBEtrotter software (FLEXlm libraries and 
utilities) into any product or application the primary purpose of which is software 
license management.
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BasicScript is a registered trademark of Summit Software, Inc.

Design Patterns: Elements of Reusable Object-Oriented Software, by Erich Gamma, 
Richard Helm, Ralph Johnson and John Vlissides. Copyright © 1995 by 
Addison-Wesley Publishing Company, Inc. All rights reserved.

Additional legal notices are described in the legal_information.html file that is 
included in your Rational software installation.
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Preface
Rational Software delivers a comprehensive set of integrated tools that embody 
software engineering best practices and span the entire software development life 
cycle. Rational Suite's unparalleled level of integration improves communication both 
within teams and across team boundaries, reducing development time and improving 
software quality. 

Purpose

This manual provides requirements and instructions for installing and licensing 
Rational products on your desktop or client for the first time. Consult with your 
systems administrator about how Rational products will be deployed in your 
environment. 

� The procedures and requirements for installing and licensing Rational server 
software are covered in the Installation Guide for Rational Server Products.

� For information about upgrading an existing Rational Suite installation, see the 
Rational Suite Upgrade Guide.
xv
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Table 1 informs you whether the product has a client component and a server 
component. If the product includes both, see the Installation Guide for Rational Server 
Products and the Installation Guide for Rational Desktop Products.

Table 1 Installation Guide Reference

Product
Client/
Server?

See Installation Guide for

Rational Suite Yes Rational Server Products
Rational Desktop Products

Rational ClearCase LT 
(includes ClearCase Web)

Yes Rational Server Products
Rational Desktop Products

Rational ClearQuest (includes 
ClearQuest Web)

Yes Rational Server Products
Rational Desktop Products

Rational ClearQuest MultiSite Yes Rational Server Products

Rational ManualTest Web 
Execution

Yes Rational Server Products
Rational Desktop Products

Rational Process Workbench No Rational Desktop Products

Rational ProjectConsole Yes Rational Server Products
Rational Desktop Products

Rational Purify, PurifyPlus, 
PureCoverage, and Quantify

No See the Rational PurifyPlus Family Release Notes for 
the most current requirements and supported 
software.

Rational QualityArchitect No Rational Desktop Products

Rational RequisitePro 
(includes RequisiteWeb)

Yes Rational Server Products
Rational Desktop Products

Rational Robot No Rational Desktop Products

Rational Rose No Rational Desktop Products

Rational Rose Data Modeler No Rose Data Modeler produces models for several 
database vendors. The vendor databases are listed 
in this guide (Desktop System and Software 
Requirements on page 27.) There are no special 
configuration instructions in either installation 
guide for Rose Data Modeler. 

To install and configure the databases, see the 
vendor documention.
xvi Installation Guide for Rational Desktop Products 
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Audience

This manual is intended for project managers, and all members of the software 
development team who are installing Rational products for the first time on their 
computers. All users must be familiar with Microsoft Windows and its conventions.

Rational Rose RealTime No Rational Rose RealTime on the Rational Solutions 
for Windows Online Documentation CD.

Rational TeamTest Yes Rational Desktop Products
Rational Server Products (to configure Test 
datastore)

Rational Test Agents 
(UNIX/Windows)

No Rational Desktop Products

Rational Test Datastore Yes Rational Server Products
Rational Desktop Products

Rational Test Enablers No Rational Desktop Products

Rational Test Manager Yes Rational Desktop Products
Rational Server Products (to configure Test 
datastore)

Rational Unified Process No See Desktop System and Software Requirements on 
page 27 for the list of supported Web browsers. 
There are no other pre- and post- installation 
requirements for Rational Unified Process.

Rational XDE Modeler and 
Rational XDE Developer

No See the printed Release Notes for XDE Modeler and 
XDE Developer in the Rational XDE media kit.

Rational XDE Tester No XDE Tester or the Release Notes for XDE Tester in 
your XDE Tester media kit.

To upgrade from Robot J to XDE Tester, see the 
Rational Suite Upgrade Guide.

Table 1 Installation Guide Reference

Product
Client/
Server?

See Installation Guide for
Preface xvii
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Other Resources

� All manuals are available online, either in HTML or PDF format. The online 
manuals are on the Rational Solutions for Windows Online Documentation CD. 

� To send feedback about documentation for Rational products, please send e-mail 
to techpubs@rational.com.

� For more information about Rational Software technical publications, see: 
http://www.rational.com/documentation. 

� For more information on training opportunities, see the Rational University Web 
site: http://www.rational.com/university.

� For articles, discussion forums, and Web-based training courses on developing 
software with Rational Suite products, join the Rational Developer Network by 
selecting Start > Programs > Rational Software > Logon to the Rational Developer 
Network.
xviii Installation Guide for Rational Desktop Products 
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Contacting Rational Customer Support

If you have questions about installing, using, or maintaining this product, contact 
Rational Customer Support as follows:

Note:  When you contact Rational Customer Support, please be prepared to supply the 
following information:

� Your name, company name, telephone number, and e-mail address

� Your operating system, version number, and any service packs or patches you 
have applied

� Product name and release number

� Your service request number (if you are following up on a previously reported 
problem)

Your Location Telephone Facsimile E-mail

North America (800) 433-5444
(toll free)

(408) 863-4000
Cupertino, CA

(781) 676-2460
Lexington, MA

support@rational.com 

Europe, Middle 
East, Africa

+31 (0) 20-4546-200
Netherlands

+31 (0) 20-4546-201
Netherlands

support@europe.rational.com 

Asia Pacific +61-2-9419-0111
Australia

+61-2-9419-0123
Australia

support@apac.rational.com 
xx Installation Guide for Rational Desktop Products 
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1Before Install
This chapter explains the tasks you must perform before you install Rational Suite or 
Rational point products on a desktop or client. It also provides checklists to help you 
install and configure the product on your desktop. This manual does not explain the 
following:

� Rational Rose RealTime installation. See the Installation Guide for Rose RealTime on 
the Rational Solutions for Windows Online Documentation CD.

� XDE Modeler and XDE Developer installation. See the Release Notes in your 
Rational XDE media kit.

� XDE Tester installation. See the Installation Guide in your Rational XDE Tester 
media kit.

� Rational server installations. See the Installation Guide for Rational Server Products.

� Setting up a release area (enterprise deployment) for client and server installations. 
See the Installation Guide for Rational Server Products.

Note:  This manual can help you install the product from a release area if your 
administrator has set it up for you. For a description of installing from a release 
area and other deployment methods, see Selecting a Deployment Type on page 37.

Removing Previous Releases of Rational Products

Before installing Rational products from version 2003.06.00, remove previous versions 
of Rational products, including the Rational license server. The only exception is 
Rational ClearCase. You can install 2003.06.00 products with older versions of 
ClearCase. 

For the removal procedure, see the Removing Rational Products chapter in this guide. 

You or your system administrator must see the Rational Suite Upgrade Guide in the 
Rational Solutions for Windows Online Documentation CD-ROM before you try to 
upgrade your Rational products.

Note:  If you are using floating licenses, record the license server name(s) before you 
remove Rational products from your computer. After you install new Rational 
products on your computer, reset the hostnames in the Rational License Key 
Administrator. For more information, see the Removing Rational Products chapter in 
this guide.
21
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Installing Mixed Versions with Rational ClearCase

You can install mixed versions with Rational ClearCase in the following cases:

� Rational ClearQuest standalone or as part of Rational Suite with Rational 
ClearCase 4.2 - 5.0.

� Rational Suite with Rational ClearCase 4.2 - 5.0.

� Rational XDE with Rational ClearCase 4.2 (fully patched) or 5.0.

Preparing for Rational Desktop Installations

Table 2 directs you to information in this manual that can help you install and 
configure Rational desktop products. 

Table 2 Rational Desktop Product Pre-Installation Tasks

To See

Prepare for a Rational Suite installation. Preparing to Install Rational Suite on page 38.

Prepare for a ClearCase LT installation. Preparing to Install Rational ClearCase LT on 
page 40.

Prepare for a ClearQuest installation. Preparing to Install Rational ClearQuest on page 43.

Prepare for a ProjectConsole and Project 
Console Template Builder installation.

Preparing to Install Rational ProjectConsole on 
page 49.

Prepare for Purify, PurifyPlus, 
PureCoverage, and Quantify installation.

See the Rational PurifyPlus Family Release Notes for 
the most current requirements and supported 
software.

Prepare for a Rational Process Workbench 
installation.

Preparing to Install the Rational Process Workbench 
on page 48.

Prepare for a RequisitePro installation. Preparing to Install Rational RequisitePro on 
page 51.

Prepare for a Rose installation. Preparing to Install Rational Rose on page 53.
22 Installation Guide for Rational Desktop Products 
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Licensing Rational Desktop Products

In most cases, you will need a license key to launch the product. Consult with your 
license administrator about which license keys are required. Your license 
administrator may have already requested permanent or evaluation license keys. 

Prepare for a Rose Data Modeler 
installation.

Rose Data Modeler produces models for several 
database vendors. The vendor databases are 
listed in this guide (Desktop System and Software 
Requirements on page 27.) There are no 
configuration instructions in either installation 
guide for Rose Data Modeler. 

To install and configure the databases, see the 
vendor documentation.

Prepare for a Rational Test installation. Preparing to Install Rational Testing Products on 
page 55.

Prepare for a Rational Unified Process 
installation.

Desktop System and Software Requirements on 
page 27 for the list of supported Web browsers. 
There are no other pre- and post- installation 
requirements for Rational Unified Process.

Prepare for an XDE Modeler and XDE 
Developer installation

Preparing to Install Rational XDE Modeler and XDE 
Developer on page 61.

Prepare for an XDE Tester installation. About Rational XDE Tester on page 61.

To upgrade from Robot J to XDE Tester, see the 
Rational Suite Upgrade Guide.

Install from the CD or from a release area. � Selecting a Deployment Type on page 37.
� Installing Rational Products on page 59.

Run a silent installation. Silent Installation Overview on page 69.

Install a service release. Applying Service Releases on page 74.

Repair or modify Rational products. Reinstalling a Product (Modify or Repair) on 
page 73.

Remove Rational products. � Removing Rational Products on page 105.
� Using the Command Line to Remove a Product on 

page 71.

Table 2 Rational Desktop Product Pre-Installation Tasks

To See
Chapter 1 - Before Install 23
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Follow the instructions in Table 3 to license your Rational product:

Using the License Key Administrator (LKAD) Wizard

Import a node-locked key or specify a floating license server in the License Key 
Administrator (LKAD) Wizard. The Setup Wizard installs the LKAD automatically 
with each Rational product. If the product is not already licensed, you can launch the 
LKAD Wizard at the end of installation, or you can open the LKAD from the Start 
Menu under the Rational Software folder. The License Key Administrator main 
window and the License Key Administrator Wizard page appear simultaneously. Use 
the LKAD Help for further assistance.

Table 3 Licensing Desktop Products

License Key
Request License 
Key from: Install License by:

Permanent 
Node-Locked

AccountLink 
(www.rational.com/
accountlink)

Importing the key on your desktop with the 
License Key Administrator (LKAD) Wizard.

Permanent Floating AccountLink 
(www.rational.com/
accountlink)

Configuring your desktop to point to the 
Rational license server using the License Key 
Administrator (LKAD) Wizard. Your 
administrator must install and set up the license 
server first. (See the Rational Software License 
Management Guide for instructions.)

If your administrator has set up a release area, 
you may not have to manually specify the 
license server in the LKAD Wizard. 

Evaluation Floating Your sales 
representative or 
the Try-It Center at 
www.rational.com.

Configuring your desktop to point to the 
Rational license server using the License Key 
Administrator (LKAD) Wizard. Your 
administrator must install and set up the license 
server first. (See the Rational Software License 
Management Guide for installation instructions.)

If your administrator has set up a release area, 
you may not have to manually specify the 
license server in the LKAD Wizard. 

Evaluation 
Node-Locked

Your sales 
representative or 
the Try-It Center at 
www.rational.com.

Importing the node-locked key on your desktop 
with the License Key Administrator (LKAD) 
Wizard.
24 Installation Guide for Rational Desktop Products 
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Licensing ClearCase LT

The ClearCase LT server and ClearCase LT client require separate floating licenses 
when they are installed on separate systems. If you are evaluating ClearCase LT, you 
need only one floating license because the ClearCase LT server acts as both server and 
client.

ClearCase LT can use a node-locked Rational Suite license key. After you have 
installed the node-locked license, use the License Usage Mapper to specify that 
ClearCase LT is to use the Rational Suite key. Rational does not provide a stand-alone 
node-locked license for ClearCase LT. See the Rational Software License Management 
Guide or the License Key Administrator Help for more information about the License 
Usage Mapper.

Licensing ClearQuest

Each ClearQuest native client requires access to a floating license or node-locked 
license.

Licensing Rose Variants

Rational Rose uses a license key for the variant of Rose that you install, or a Rational 
Suite key that includes that Rose variant. 

Licensing Rational Testing Products

This section describes the types of licenses you need to use Rational testing products.

� Rational Suite TestStudio requires floating licenses. 

� Virtual Tester and Protocol licenses for performance testing require floating 
licenses.

� To record GUI test scripts on multiple computers, you need to install Rational 
Robot standalone on each computer. A separate node-locked license is required for 
Robot-only installations.

Licensing Web Clients

To use ClearCase Web, ClearQuest Web, RequisiteWeb, and ProjectConsole, your 
license administrator should install floating licenses on a Rational license server. The 
Web server (ClearQuest Web server or Rational Web Platform) requests a license key 
from the Rational license server for each Web client. You do not have to install a 
license key on your desktop to use the Web client.
Chapter 1 - Before Install 25



rs_install_desktop.book  Page 26  Wednesday, April 16, 2003  4:52 PM
Licensing Products on Windows Terminal Servers

To use Rational products that support hosted development on Windows Terminal 
Servers, you must have floating licenses.

Using the License Management Guide

For more information about the licensing tasks or product-specific licensing, see the 
Rational Software License Management Guide on the Rational Solutions for Windows Online 
Documentation CD. The Rational Software License Management Guide describes 
AccountLink, Rational licensing terms, and the Rational License Key Administrator 
(LKAD). It provides instructions for requesting, installing, upgrading, and 
configuring floating and node-locked keys. 

Administrator Privileges

To install Rational products on a Windows operating system, ensure you are logged 
on with appropriate privileges. You must be logged on to a Windows domain account 
that is a member of the local computer’s Administrators group.
26 Installation Guide for Rational Desktop Products 
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Desktop System and Software Requirements

Table 4 provides the recommendations and requirements for operating Rational 
desktop products on your desktop. See the specific product section in this chapter for 
additional requirements.

Table 4 Desktop Requirements and Recommendations

Item Requirements and Recommendations

Operating 
Systems

� Microsoft Windows XP Professional, Service Pack 1
� Microsoft Windows 2000 Professional, Service Pack 2, 3
� Microsoft Windows NT 4.0 Workstation, Service Pack 6a + SRP 

(Security Rollup Package, Q299444)

Notes:

PurifyPlus supports additional operating systems. See the PurifyPlus 
Family Release Notes in the Rational Solutions for Windows Online 
Documentation CD for more information.

Robot and TestManager also support:

Windows 98, 98SE, and ME. However, the TestManager installation does 
not include the Rational Administrator if TestManager is installed on 
Windows 98, 98SE, or ME.

XDE:
� For the latest information about XDE operating system support, see 

the Release Notes for Rational XDE.

The production release of Windows 2003 Server was not available for 
final testing at the time this document was finalized. Please visit our web 
site www.ibm.com/software/rational/ to obtain the latest information on 
Windows 2003 support.

Hardware � 500-600 MHz or higher
� 256-512+ MB RAM;

more memory generally improves performance
� Swap space: 2 x physical memory
� 800 X 600 X 256-color video resolution, or higher; high color or true 

color recommended
� Microsoft mouse or compatible pointing device

Notes:

XDE:
� 512 MB RAM; 1 GB recommended for Developer versions.
Chapter 1 - Before Install 27
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Remote Access 
Support

See the Server Requirements and Recommendations table in the 
Installation Guide for Rational Server Products or the Rational Suite 
Release Notes.

Rational Suite
Disk Space

� Rational Suite Enterprise – 1.6 GB (full), 1.2 GB (typical)
� Rational AnalystStudio – 1.2 GB (full), 851 MB (typical)
� Rational DevelopmentStudio – 1.4 GB (full), 1.1 GB (typical)
� Rational DevelopmentStudio for UNIX (Windows components only) – 

515 MB (full), 445 MB (typical)
� Rational DevelopmentStudio – RealTime Edition – 1.4 GB (full), 

1.1 GB (typical)
� Rational DevelopmentStudio – RealTime Edition for UNIX (Windows 

components only) – 515 MB (full), 445 MB (typical)
� Rational TestStudio – 1.4 GB (full), 1.1 GB (typical)
� Rational TeamTest – 645 MB (full), 583 MB (typical)
� Rational Team Unifying Platform – 1.1 GB (full), 825 MB (typical)

Table 4 Desktop Requirements and Recommendations (continued)

Item Requirements and Recommendations
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Point Product
Disk Space

ClearCase LT client file storage space:

Rational ClearCase LT needs enough disk space on the desktop to 
contain all files loaded into snapshot views and all view-private files 
added to the views. The amount of space required depends on the 
number and sizes of the files in the views.

� ClearQuest native client: 371 MB (full), 321 MB (typical)
� ClearQuest Web client: 50 MB (browser + JRE)
� PurifyPlus for Windows: 70 MB (full), 68 MB (typical)
� QualityArchitect: 250 MB
� Rational Test Agent: 425 MB (We recommend more disk space for 

large virtual tester runs.)
� Rational Unified Process: 195 MB (full/typical)
� Rational Unified Process Modeler: 50 MB
� Rational Unified Process Organizer: 2-4 GB
� RequisitePro: 192 MB (full), 176 MB (typical)
� Robot: 282 MB (full/typical)
� Rose Enterprise Edition: 456 MB (full/typical)
� SoDA: 150 MB (Microsoft Word), 100 MB (FrameMaker)
� TestManager: 379 MB (full/typical)
� XDE: 500 MB (minimum) for installation drive, 100 MB for workspace, 

2-5 GB recommended for workspace

Integrations with 3rd Party Applications

ClearCase LT � Microsoft Office 2000 Service Pack 1, 2; 2002 without a Service Pack or 
Service Pack 1

� Microsoft Word 2000 Service Pack 1, 2; 2002 without a Service Pack or 
Service Pack 1

ClearQuest � Crystal Reports 8.0, 8.5 (recommended for customizing standard 
reports)

� Microsoft Project 98, 2000, 2002
� Visual Source Safe 6.0, Service Pack 3 .NET

ProjectConsole 
Template Builder

� Microsoft Word 2000 Service Pack 1; Word 2002
(required to create ProjectConsole Template Builder templates)

Table 4 Desktop Requirements and Recommendations (continued)

Item Requirements and Recommendations
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Integrations with 3rd Party Applications

(Purify 
PurifyPlus 
PureCoverage 
Quantify

For the latest support information, see the PurifyPlus Family Release 
Notes in the Rational Solutions for Windows Online Documentation 
CD.

RequisitePro � Microsoft Word 2000 Service Pack 1, 2; Word 2002 , Service Pack 1, 2
� Microsoft Excel 2000, Service Pack 1, 2; Excel 2002, Service Pack 1, 2

Rose Microsoft JVM Build 3809

Robot and 
TestManager

� If you are developing or running test scripts written in the Visual 
Basic language, Visual Basic 6 is required.

� If you are developing or running Java test scripts, a JDK (Java 
Development Kit) is required.

SoDA � Microsoft Word 2000 Service Pack 1, 2; Word 2002 , Service Pack 1 

Table 4 Desktop Requirements and Recommendations (continued)

Item Requirements and Recommendations
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IDEs, Integrations with 3rd Party Development Applications, Add-Ins, and 
Hosted Development Systems

ClearCase LT � Forte for C++ 6.x, Update 1
� Forte for Java 2.0, 3.0
� IBM VisualAge for Java 3.5.3, 4.0
� IBM WebSphere Application Developer 5.0
� IBM WebSphere Application Developer Integration Edition 5.0
� IBM WebSphere Studio Enterprise Developer 5.0
� IBM WebSphere Studio Site Developer 5.0
� JBuilder 4.x – 8.x
� Microsoft PowerBuilder 6.x – 9.x 
� Microsoft Visual Basic 6.0, Service Pack 4, 5
� Microsoft Visual C++ 5.0, 6.0, Service Pack 4, 5
� Microsoft Visual InterDev 6.0
� Microsoft Visual J++ 6.0, Service Pack 4, 5
� Microsoft Visual Studio .NET 7.0, Service Pack 1 (with .NET 

Framework Service Pack 2); Studio .NET 7.1
� Oracle JDeveloper 9.0
� SunOne for Java 4.0
� WebGain Studio 4.5.2
� WebGain Visual Cafe 4.1 Expert Edition, 4.5.2 or higher Expert and 

Enterprise Editions

ClearQuest � Microsoft Visual Studio.NET, Service Pack 1 (with .NET Framework 
Service Pack 2)

� IBM WebSphere Application Developer 5.0
� IBM WebSphere Application Developer Integration Edition 5.0
� IBM WebSphere Studio Enterprise Developer 5.0
� IBM WebSphere Studio Site Developer Advanced 5.0 

Table 4 Desktop Requirements and Recommendations (continued)

Item Requirements and Recommendations
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IDEs, Integrations with 3rd Party Development Applications, Add-Ins, and 
Hosted Development Systems

Rose � Rose Visual Basic: Microsoft Visual Basic 6.0 (Visual Studio 6.0)
� Rose Visual C++: Microsoft Visual C++ 6.0 (Visual Studio 6.0 )
� Rose J: JDK 1.1.6 

Rose Add-Ins that use a Web browser (for example, Web Publisher) 
support most common browsers.

Rose J supports the following Java IDEs. Use the JDK appropriate to your 
IDE.
� VisualCafe in Studio 4.0, 4.1 Standard, Professional, Enterprise, and 

Expert Editions 
� IBM VisualAge for Java 3.5, 3.5.3, 4.0 Professional and Enterprise 

Editions 
� Forte for Java Community Edition 3.0 and 4.0
� Forte for Java Enterprise Edition 3.0  and 4.0
� Sun One Studio 3 and 4 Community and Enterprise Edition
� JBuilder 4.0, 5.0, 6.0, 7.0, 8.0 Enterprise, Professional and Foundation 

Editions

Table 4 Desktop Requirements and Recommendations (continued)

Item Requirements and Recommendations
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Rose Data 
Modeler

Rose Data Modeler can produce data models for the following databases:
� IBM DB2 Universal Database + Client 5.x, 6.x, and 7.x
� IBM DB2 OS390 + Client 5.x, 6.x
� Microsoft SQL Server 6.x, 7.x
� Oracle server + Client 7.x, 8.x, and 9.x
� Sybase SQL Anywhere 8.0.1 is available on the Rational Solutions for 

Windows installation disc. It is configured to work only with Rational 
products. Select SQL Anywhere from the Product Selection list in the 
Rational Setup Wizard. 

� Sybase System 12
� SQL Server 2000

To reverse engineer Oracle and DB2 databases using Rose Data Modeler, 
an RDMS client must be installed.

Note: Rose Data Modeler also supports Oracle on Solaris 2.6, 7-9 and 
HP-UX 11.0 QPK1100, 11.11 GoldQPK11i and Bundle11i.

Make sure that the database server meets these minimum requirements:
� Operating system: Windows NT 4.0 Server or Workstation 4.0 
� Processor: Pentium 
� Memory: 64 MB 
� Disk space: 1.3 GB (minimum) 

Rose RealTime For the latest support information, see the Release Notes for Rose 
RealTime in the Rational Solutions for Windows Online Documentation 
CD.

XDE For the latest support information, see the printed Release Notes for XDE 
Developer and XDE Modeler in your XDE media kit.

XDE Tester For the latest support information, see the printed Release Notes for XDE 
Tester in you XDE Tester media kit.

Table 4 Desktop Requirements and Recommendations (continued)

Item Requirements and Recommendations
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Rational Test 
Agent Software

In addition to the three listed as supported by all desktop products, you 
can install Test Agents on the following operating systems:

Windows
� Microsoft Windows 2000 Server, Service Pack 2, 3
� Microsoft Windows 2000 Advanced Server, Service Pack 2, 3
� Microsoft Windows NT 4.0 Server, Service Pack 6a + SRP (Security 

Rollup Package, Q299444)
� Microsoft Windows Millennium Edition
� Windows 98 2nd edition

Note: If you use Windows XP Professional, ensure that Service Pack 1 is 
installed. 

UNIX
� AIX 4.3
� HP-UX 11
� Solaris 2.6, 7- 9
� Red Hat 7.1, 7.2, and 7.3 and 8.0 Personal Linux
� Red Hat 7.1, 7.2, and 7.3 and 8.0 Professional Linux

� If you are running test scripts written in the Visual Basic language,
VB 6 is required.

� If you are running Java test scripts, a JDK is required.
� Install TCP/IP on all Test Agents.

Table 4 Desktop Requirements and Recommendations (continued)
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Web Browsers on 
Windows

� Microsoft Internet Explorer 5.5, Service Pack 1, 2; 6.0 without a Service 
Pack or Service Pack 1

� Netscape Navigator 4.72 – 4.78, 7.0

Notes:
� ClearCase Web and ClearQuest Web support Internet Explorer and 

Netscape Navigator 7.0 on Windows 98 2nd Edition, Windows ME, 
and Windows XP Home. 

� ClearCase Web and ManualTest Web do not support Netscape 
Navigator 4.7x.

� ProjectConsole does not support Netscape Navigator 4.72 – 4.78
� RequsiteWeb also supports Netscape Navigator 4.70, 4.71
� RUP Modeler and RUP Organizer support Netscape Navigator 

versions 6.2.1 and 6.2.3.
� Some Rational products (including some Rose Add-In's) may require 

certain Microsoft Internet Explorer components. Rose is tested with 
one of the recommended versions of Internet Explorer. Attempting to 
install and run Rose without Internet Explorer installed may cause 
unpredictable results. However, you are not required to use Internet 
Explorer as your browser.

Table 4 Desktop Requirements and Recommendations (continued)
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Web Clients on 
Non-Windows 
Platforms

ClearCase Web
� Netscape Navigator 7.0 on SuSE Linux 8.0, AIX 4.3.3, 5.1, 5.2, HP-UX 

11.x, Solaris 2.6, 7– 9 

ClearQuest Web
� Netscape Navigator 7.0 on Red Hat Linux 7.1 - 7.3, SuSE Linux 8.0, 

AIX 4.3.3, 5.1, 5.2, HP-UX 11.x, Solaris 2.6, 7– 9 
� Netscape Navigator 4.72 – 4.78 on Red Hat Linux 7.1 - 7.3, AIX 4.3.3, 

5.1, 5.2, HP-UX 11.x, Solaris 2.6, 7– 9

ManualTest Web
� Netscape Navigator 4.78 on Solaris 2.9 (You can see the manual test 

scripts, but you cannot run and save the results to the project.
� Netscape Navigator 4.78 on Red Hat Linux 7.3
� Netscape Navigator 7.0 on Solaris 2.9

ProjectConsole
� Netscape Navigator 7.0 on Red Hat Linux 7.1 - 7.3, SuSE Linux 8.0, 

AIX 4.3.3, 5.1, 5.2, HP-UX 11.x, Solaris 2.6, 7– 9 

RequisiteWeb and Rational Unified Process
� Netscape Navigator 4.72-4.78
� Netscape Navigator 7.0 on SuSE Linux 8.0

Rose Web Publisher
� Netscape Navigator 4.7x on Solaris 2.6, 7– 9, and HP-UX 11.x
� Netscape Navigator 4.74 on Red Hat Linux 7.1 - 7.3

XDE Web Publisher
� Netscape Navigator 7.0 on Red Hat Linux 7.1 - 7.3, SuSE Linux 8.0
� Netscape Navigator 4.72 – 4.78 on AIX 4.3.3, 5.1, 5.2, HP-UX 11.x, 

Solaris 2.6, 7– 9

Automated 
License Key 
Requests

Internet Connection to request and receive license key files. For more 
information, see the Rational Software License Management Guide.

Dual Boot 
Systems

Rational Suite and Rational Rose do not support dual boot systems 
where both operating systems are on the same partition.

Rational 
Documentation

Adobe Acrobat Reader 4.x or higher to read online PDF files. Download 
a free version of Adobe Acrobat Reader from http://www.adobe.com.

Table 4 Desktop Requirements and Recommendations (continued)
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Selecting a Deployment Type

The Rational Setup Wizard provides several deployment types, allowing you to install 
the configuration most appropriate for your desktop. If your systems administrator is 
planning the Rational product installation for your work environment, consult with 
your administrator before you select a deployment type. Your administrator may 
have created several release areas from which you can install Rational products by 
clicking a shortcut or performing a silent installation.

Language 
Support

You can install Rational products on these international operating 
systems: 
� Simplified or Traditional Chinese
� Dutch
� French
� German
� Hebrew
� Italian
� Japanese
� Korean
� Swedish

All displays, menus, controls, wizards, reports, and user documentation 
are in U.S. English. 
� If you have a Traditional Chinese, Dutch, Hebrew, or Korean 

operating system, enter data (such as path names) in U.S. English or 
the ASCII character set.

� If you have a Simplified Chinese, French, German, Italian, Japanese, 
or Swedish operating system, enter data in U.S. English or the native 
language character set. Regional date, time, currency, and numbering 
conventions are also supported for both input and output. 

Table 4 Desktop Requirements and Recommendations (continued)
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Table 5 describes each deployment type. You can find instructions for each 
deployment type in Installing Rational Products on page 59.

Preparing to Install Rational Suite

Use Table 6 to help you install a Rational Suite edition on your desktop. If you are 
installing ClearCase LT and Rational Suite for evaluation purposes, see the Before You 
Install chapter in the Installation Guide for Rational Server Products.

To install the Rational Suite servers, see the Installation Guide for Rational Server 
Products.

Table 5 Rational Setup Wizard Deployment Types 

Type Description

Desktop Installation 
from CD Image

This deployment type allows you to install the desktop product or 
client software directly from the Rational Solutions for Windows CD 
onto your desktop. Place the CD into the CD drive of the computer 
and launch the Rational Setup Wizard.

Enterprise 
Deployment

This option enables your administrator to create a network release 
area and customize the product installation. Using the site defaults 
file created in the Rational Setup Wizard, you can either install pre-set 
configurations of the product or install the product with different 
defaults.

The advantage of Enterprise Deployment is that multiple clients can 
install from a designated release area. When a service release becomes 
available it can be applied to the release area and then clients can 
reinstall from the updated release area. 

Silent Installation This deployment type does not appear in the Setup Wizard. To 
perform a silent installation, your administrator creates a site defaults 
file and directs you to use specific commands to perform a silent 
installation based on settings in this file. Silent installations ensure 
that all users have the same products, features, and options on their 
desktops. For more information, see Using Silent Installation 
Commands on page 69.
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For the latest Rational Suite installation information, see the Rational Suite Release 
Notes. To access the release notes, use the Rational Solutions for Windows Online 
Documentation CD. You can also view them after the Rational Suite installation, or 
launch them by clicking Start > Programs > Rational Software > Rational Suite > 
Rational Suite readme after you install the software.

Note:  Rational XDE Modeler, Rational XDE Developer, and Rational XDE Tester are 
add-on products.

Table 6 Rational Suite Desktop Installation Checklist

Done Task

Before Installation

Get a license key to run the Rational Suite on your desktop. See Licensing Rational 
Desktop Products on page 23 

Look at the list of products in your Rational Suite edition and perform the installation 
tasks for each of the products:

� Preparing to Install Rational ClearCase LT on page 40
� Preparing to Install Rational ClearQuest on page 43
� Preparing to Install the Rational Process Workbench on page 48
� Preparing to Install Rational ProjectConsole on page 49
� Preparing to Install Rational RequisitePro on page 51
� Preparing to Install Rational Rose on page 53
� Preparing to Install Rational Testing Products on page 55

If you are only installing the Rational Unified Process, ensure that you have a 
supported browser installed on your desktop. There are no other requirements.

Ask your administrator for the correct deployment type. See Selecting a Deployment 
Type on page 37.

Installing Rational Suite

To install Rational Suite from one of the deployment options described in this 
chapter, see Installing Rational Products on page 59.
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Preparing to Install Rational ClearCase LT 

This section describes requirements for installing Rational ClearCase LT client or 
configuring ClearCase LT Web client on your desktop. To install the ClearCase LT 
server, see the Installation Guide for Rational Server Products. 

For the most current information related to ClearCase LT features and known issues, 
see the ClearCase LT Release Notes in the Rational Solutions for Windows Online 
Documentation CD, view them after the ClearCase LT installation, or launch them from 
the Start Menu by clicking Start > Programs > Rational Software > Rational ClearCase 
LT > Rational ClearCase LT readme after you install the software.

Installing Variants on the Same Desktop

If you plan to upgrade to Rational ClearCase in the future, you can upgrade 
ClearCase LT to ClearCase within the same version 2003.06.00. See the Installation 
Guide for Rational ClearCase in the Rational ClearCase CD for installation 
requirements.

After Installation

Ensure your system administrator has set up and started the Rational Suite servers 
before you start post-installation tasks. Skip features that either may not be included 
in your Rational Suite or that have not been configured by your administrator. 
� ClearCase LT Native Client Installation Checklist on page 41
� ClearCase Web Client Installation Checklist on page 42
� ClearQuest Native Client Installation Checklist on page 44
� ClearQuest Web Client Installation Checklist on page 45
� ProjectConsole Web Client Installation Checklist on page 49
� RequisitePro Native Client Installation Checklist on page 52
� RequisitePro Web client Installation Checklist on page 53
� Rose Desktop Installation Checklist on page 54
� Rational Testing Desktop Installation Checklist on page 55

Table 6 Rational Suite Desktop Installation Checklist

Done Task
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Use the checklist in Table 7 to help you install ClearCase LT client on your desktop. 
Use the checklist in Table 8 to help you configure ClearCase Web client.
. 

Table 7 ClearCase LT Native Client Installation Checklist

Done Task

Before Installation

Get a license key to run ClearCase LT on your desktop. See Licensing Rational 
Desktop Products on page 23. 

Check the system and software requirements for running ClearCase LT on your 
desktop. See the following sections for more information:
� Desktop System and Software Requirements on page 27.
� Installing Internet Explorer on page 42.

Check with your administrator that the ClearCase LT server has been installed and 
configured before you use ClearCase LT. 

If you are installing ClearCase LT as part of a Rational Suite, see Installing 
ClearCase LT Client as Part of a Rational Suite on page 42.

Ensure that you have administrator privileges on your desktop. See Administrator 
Privileges on page 26.

Ask your administrator for the correct deployment type. See Selecting a Deployment 
Type on page 37.

Set the CLEARCASE_PRIMARY_GROUP Environment Variable. See Set the 
CLEARCASE_PRIMARY_GROUP Environment Variable on page 42.

Installing ClearCase LT

To install ClearCase LT from one of the deployment options described in this 
chapter, see Installing Rational Products on page 59.

Your administrator should give you the name of the ClearCase LT server if you are 
installing ClearCase LT from CD. 

If you are installing from a release area, the server name may already be included in 
the site defaults file.

After Installation

Create a view. See Creating Views on page 75.
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Installing ClearCase LT Client as Part of a Rational Suite

If you are installing a Rational Suite that includes ClearCase LT, your administrator 
must install and configure the ClearCase LT server before you can use the ClearCase 
LT client. When you install a Rational Suite edition on your client desktop, the 
ClearCase LT client software is installed, by default, as part of the Rational Suite. The 
ClearCase LT server software is not installed with the Rational Suite.

Note:  Do not install the Rational Suite before you try to install the ClearCase LT server 
on the same computer (Installing all ClearCase software on the same computer is not 
recommended unless you are evaluating ClearCase LT.).

Installing Internet Explorer

Several programs installed with ClearCase LT depend on components of Microsoft 
Internet Explorer, and will not work unless Internet Explorer has been installed on the 
system. You can find the required versions in Desktop System and Software Requirements 
on page 27. You can download Internet Explorer from the Microsoft Web site at 
www.microsoft.com/windows/IE. For more information, see the Release Notes for Rational 
ClearCase LT.

Set the CLEARCASE_PRIMARY_GROUP Environment Variable

ClearCase LT access controls consider domain group membership information when 
determining a user ’s rights to access ClearCase data. In Windows, a user who logs on 
to a domain account may not be assigned the primary group specified by the 
Windows domain account management tools. 

To ensure proper assignment, set the user environment variable 
CLEARCASE_PRIMARY_GROUP to refer to the correct primary group. The value of 
this variable must be the name of an existing domain group that includes the user as a 
member. All ClearCase users must be members of this group. This user environment 

Table 8 ClearCase Web Client Installation Checklist

Done Task

Make sure you have installed one of the supported Web browsers. See Desktop 
System and Software Requirements on page 27 and Installing Internet Explorer on 
page 42. You do not need a license key or ClearCase LT software on your client to 
use ClearCase Web. 

Ask your administrator if the ClearCase LT server has been installed and 
configured. If it has, see Logging in to ClearCase Web on page 76.
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variable (not system environment variable) must be set on every ClearCase computer. 
On Windows systems, set the value of CLEARCASE_PRIMARY_GROUP using the 
System program in Control Panel. 

For more information on CLEARCASE_PRIMARY_GROUP and ClearCase access 
controls, see the Administrator’ s Guide for ClearCase.

Preparing to Install Rational ClearQuest

This section describes requirements for installing ClearQuest client on your desktop. 
To install the ClearQuest and ClearQuest MultiSite servers and administration tools, 
see the Installation Guide for Rational Server Products.

For the most current information related to ClearQuest features and known issues, see 
the Release Notes for ClearQuest in the Rational Solutions for Windows Online 
Documentation CD, view them after the ClearQuest installation, or launch them by 
clicking Start > Programs > Rational Software > Rational ClearQuest > Rational 
ClearQuest readme after you install the software.

Use the checklist in Table 9 to help you install ClearQuest client software. Use the 
checklist in Table 10 to help you set up ClearQuest Web client on your desktop.
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Table 9 ClearQuest Native Client Installation Checklist

Done Task

Before Installation

Get a license key to run the ClearQuest client on your desktop. See Licensing 
Rational Desktop Products on page 23 

Ensure that you have administrator privileges on your desktop. See Administrator 
Privileges on page 26.

Ask your administrator for the correct deployment type. See Selecting a Deployment 
Type on page 37.

If the ClearQuest native client is accessing a ClearQuest database running DB2 or 
Oracle, install an Oracle or DB2 client on the client computer. See Installing the 
Oracle Client or the DB2 Client on page 46. 

Check the system and software requirements for running ClearQuest on your 
desktop. See the following sections for more information:
� Desktop System and Software Requirements on page 27.
� Compatibility Issues on page 45.
� Setting Up the VS.NET Integration on page 45.

Installing ClearQuest

To install ClearQuest from one of the deployment options described in this chapter, 
see Installing Rational Products on page 59.

After Installation

Check with your administrator that the ClearQuest database server has been 
installed and configured before you set up the ClearQuest native client. 

If you are using Oracle or DB2 as the ClearQuest database, create a database alias. 
See Creating a DB2 Database Alias on page 77 or Creating an Oracle Database Alias on 
page 78.

Connect to the ClearQuest databases. See Connecting to ClearQuest Databases on 
page 78

Log in to ClearQuest. See Logging In to ClearQuest on page 81.

Enable e-mail notification if you did not enable it when you installed the 
ClearQuest client from a CD, or if your administrator did not include the 
information in a site defaults file. See Configuring Your ClearQuest Client to Receive 
E-Mail Notification on page 81 and Configuring Your ClearQuest Client to Send E-Mail 
Notification on page 81.
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Compatibility Issues

With Rational Products

This release is compatible with Rational ClearQuest 2003.00.06, and with all other 
Rational Suite Version 2003 products. It is not compatible with previous releases of 
ClearQuest or Rational Suite. 

With Third-Party Products

Internet Explorer 6.0 on Windows XP Operating Systems

Internet Explorer 6.0 on Windows XP operating systems does not come with a JVM 
installed. When you install ClearQuest Web in this environment, a dialog box opens 
that allows you to download JVM to your desktop. If you do not install it, ClearQuest 
Web will not work properly.

Setting Up the VS.NET Integration

If ClearCase LT is already installed, the ClearQuest/VS.Net integration is 
automatically configured at installation. After installing ClearQuest, when you start 
VS.Net, the Workspace Tree control and the Activity Grid Control will support the 
ClearQuest integration.

Table 10 ClearQuest Web Client Installation Checklist

Done Task

Ask your administrator if the ClearQuest Web server has been installed and 
configured before you read through the rest of this checklist.

Install the one of the supported Web browsers. See Desktop System and Software 
Requirements on page 27 and Installing Web Browsers on page 46. You do not have 
to install ClearQuest software or a license key on your desktop to use 
ClearQuest Web.

Configure the browser. See Configuring Web Browsers on page 46.

Log in to ClearQuest Web. See Logging In to ClearQuest Web on page 83.

Configure your ClearQuest Web client to receive e-mail notification. See 
Configuring Your ClearQuest Web Client To Receive E-Mail Notification on page 83.

Use the Advance Query Editor (optional). See Using the Advanced Query Editor 
on page 83.
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Installing the Oracle Client or the DB2 Client

ClearQuest client users must install the correct client software on their computers to 
access an Oracle ClearQuest database or DB2 ClearQuest database. 

� To install Oracle Client software for an Oracle ClearQuest database, follow the 
Oracle Networking Products documentation. 

� To install DB2 Client software for a DB2 ClearQuest database, follow the IBM DB2 
database documentation. 

Note:  The DB2 Administration Client must be installed on all computers. 

Installing Web Browsers

To use the ClearQuest Web capability, ensure that your client machine has the 
appropriate browser versions. See Desktop System and Software Requirements on 
page 27 for information on the supported browsers.

To use ClearQuest Web and the Advanced Query Editor, install either Java Runtime 
Environment (JRE) 1.3.x or 1.4.x. 

If you are using Internet Explorer to access ClearQuest Web, ClearQuest Web will 
determine if the existing JVM is sufficient to use with ClearQuest Web. If the existing 
JVM is not sufficient, you will prompted to download the required JVM.

If you are using Netscape Navigator to access ClearQuest Web, you are prompted to 
download a Java plug-in if the Java plug-in is not enabled.

Configuring Web Browsers

To get full ClearQuest Web functionality for your ClearQuest Web client, verify that 
the following options have been enabled on your Web browser. Follow the 
appropriate steps depending on whether your Web user is invoking an Internet 
Explorer browser or a Netscape browser.

Configuring the Internet Explorer Browser

To configure your Internet Explorer:

1 Start Internet Explorer from your desktop.

2 Select Tools > Internet Options from the browser tool bar.
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3 Click the Security tab and then click Custom Level.

a For ActiveX controls and plug-ins, click Enable for the following options:

� Download signed ActiveX controls

� Run ActiveX controls and plug-ins (this is for the ClearQuest Advanced 
Query Editor feature)

� Script ActiveX controls marked safe for scripting

b For Microsoft VM, enable Java permissions by clicking on any of the following 
conditions:

� Custom 

� High Safety 

� Medium Safety 

� Low Safety

4 Click the Privacy tab and then click Advanced.

5 Click Override automatic cookie handling and then click the Always allow session 
cookies option.

Configuring the Netscape Browser

To configure your Netscape browser:

1 Start Netscape Navigator from your desktop.

2 Select Edit > Preferences from the browser tool bar.

3 For Netscape 4.x:

Expand the Advanced node in the left pane tree and verify that the following 
options as a minimum are enabled:

❑ Enable Java

❑ Enable JavaScript

❑ Accept only cookies that get sent back to original server
Or
Accept all cookies
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For Netscape 7:

❑ Expand the Advanced node in the left pane tree and verify that the Enable Java 
option is enabled. 

❑ Under the Advanced node, click Scripts & Plugins and verify that the Enable 
JavaScript option for Navigator is enabled. 

❑ Expand the Privacy & Security node in the left pane tree and click Cookies. 
Verify that the Enable cookies for the originating web site only or the Enable all 
cookies options are enabled. 

4 Then click the Advanced > Cache category.

5 Set Document in cache is compared to document on network to Every time.

6 Click OK. 

Preparing to Install the Rational Process Workbench

The Rational Process Workbench (RPW), an add-on product to the Rational Unified 
Process (RUP), is used to create RUP Plug-ins. These are used to package process 
assets such as guidance, templates and examples so that they can be reused in another 
project. RPW has several components:

� RUP Organizer is a process content management tool that enables you to create 
Thin Plug-ins of reusable process assets quickly and easily, associating them with 
the architecturally robust process definition of RUP. It can also be used with more 
sophisticated Modeled Plug-ins. RUP Organizer is installed by default when you 
install RPW.

� RUP Modeler is a SPEM-compliant process-modeling tool used to do more 
sophisticated process definitions with the RUP. It is used to model plug-ins that 
add new roles, activities or artifacts to the RUP. It is an add-in to Rational XDE 
Professional Java Platform Edition, and XDE must be installed and configured 
before RUP Modeler will work. RUP Modeler is not installed by default, and must 
be selected in a custom install. 

� Several process models and content libraries for RUP, the process engineering 
process and various plug-ins. These are used as references for plug-ins and as 
sources for plug-in content that organizations wish to modify for their specific 
needs.

You can download the Rational Process Workbench from the RUP Plug-in Exchange 
on the Rational Developer Network (www.rational.net\rupexchange). Full installation 
instructions are available there.
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For the most current information related to Rational Process WorkBench features and 
known issues, refer to the Release Notes for Rational Process WorkBench on the Rational 
Solutions for Windows Online Documentation CD. The release notes also appear at the 
end of the product installation. 

Preparing to Install Rational ProjectConsole

This section describes how to set up a ProjectConsole client on your desktop and how 
to install the ProjectConsole Template Builder. This section is intended for team 
members who want to access the ProjectConsole Web site from a Web browser to view 
up-to-date project information. See the Installation Guide for Rational Server Products 
to install and configure the following ProjectConsole components:

� Web server components

� report server and collection agent

� repository

For the most current information related to ProjectConsole features and known issues, 
see the Rational Suite Release Notes in the Rational Solutions for Windows Online 
Documentation CD, view them at the end of the ProjectConsole installation, or launch 
them by clicking Start > Programs > Rational Software > Rational Suite > Rational Suite 
readme after you install the software.

Setting Up a ProjectConsole Web Client and the Template Builder

Use the checklist in Table 11 to help you set up the ProjectConsole Web client and the 
Project Console Template Builder on your desktop. The procedures are in the sections 
following the checklist. There are no post-installation tasks for the ProjectConsole 
Web client.

Table 11 ProjectConsole Web Client Installation Checklist

Done Task

Check the system and software requirements for the ProjectConsole Template 
Builder and the supported Web browser that you need to run the ProjectConsole 
Web client. See Desktop System and Software Requirements on page 27.

The ProjectConsole Template Builder software is included in your Rational Suite 
installation. 

Check with your administrator that the ProjectConsole Web site is operating 
before you continue with this checklist.

Set the minimum screen area for your browser.
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Setting the Screen Area for Your Monitor

To use the ProjectConsole Web site, set the screen area for your monitor to at least 1024 
x 768 pixels. Otherwise, you may have problems accessing key ProjectConsole 
components.

Enabling Cookies

To use the ProjectConsole Web site, enable cookies in your Web browser. For 
information about how to enable cookies, see Help for your Web browser.

Logging in to the ProjectConsole Web Site

To log in to the ProjectConsole Web site for the first time:

1 Ask your administrator for the ProjectConsole Web server name.

2 Start your Web browser, and then type the following:

http://<server name>/ProjectConsole

where server name is the name of the ProjectConsole server.

3 Press RETURN.

The ProjectConsole Logon page appears.

4 In the Username box, type admin.

5 Leave the Password box empty.

6 Click Logon.

In your Web browser, enable cookies.

Log in to the ProjectConsole Web site.

Install the Java plug-in (first time only installations).

Determine if you want to install the Template Builder software on your desktop. 
See Installing ProjectConsole Template Builder on page 51.

Table 11 ProjectConsole Web Client Installation Checklist

Done Task
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Installing the Java Plug-In

The first time you log in to the ProjectConsole Web site, you are prompted to install 
the required Java plug-in, if it is not already installed on your computer. 

To install the Java plug-in:

� Follow the instructions provided for installing the plug-in.

After you install the Java plug-in, do the following:

� If the client computer is running Windows NT, restart the system.

� If the client computer is running Windows 2000 or XP, close the Designer (or 
Dashboard) Window, and then, on the ProjectConsole toolbar, click Designer (or 
Dashboard) again.

Note:  When you start the ProjectConsole Dashboard tool on the Web site for the first 
time, you are prompted to download some Java classes. Follow the instructions for 
downloading the classes.

Installing ProjectConsole Template Builder

You can install Template Builder on any computer on which you want to create or 
modify ProjectConsole report templates. To test the templates created in Template 
Builder, install the source point product on the Template Builder computer.

To generate reports using Template Builder templates, it is not necessary to install 
Template Builder on the ProjectConsole Web server or on a report server and 
collection agent computer. 

If you use Template Builder to create templates on your desktop client, save the 
templates to the Templates folder in the ProjectConsole installation directory on the 
server computer. 

Note:  If you have ProjectConsole report server and collection agent software installed 
on your desktop, you do not have to save the templates on the ProjectConsole server. 
To install the report server and collection agent on your desktop, see the Installation 
Guide for Rational Server Products.

Preparing to Install Rational RequisitePro

This section describes how you can install RequisitePro client or access the 
RequisitePro database through RequisiteWeb. Speak to your systems administrator 
about the best option for you. If you install the RequisitePro client, you can use 
RequisiteWeb too. To install the RequisitePro database server, see the Installation Guide 
for Rational Server Products.
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For the most current information related to RequisitePro features and known issues, 
refer to the release notes in the Rational Solutions for Windows Online Documentation 
CD. The release notes also appear at the end of the installation and are available from 
a link in the Let’s Go Rational RequisitePro application, which appears when you first 
launch RequisitePro. In addition, you can view the release notes from the Start Menu 
by clicking Start > Programs > Rational Software > Rational RequisitePro > Rational 
RequisitePro readme. 

Setting Up the RequisitePro Client

Use the checklist in Table 12 to configure RequisitePro client on your desktop.
T

Installing the Oracle Client

To access an Oracle RequisitePro database, install the correct client software on your 
desktop. To install Oracle client software, follow the Oracle database documentation.

Table 12 RequisitePro Native Client Installation Checklist

Done Task

Before Installation

Get a license key to run RequisitePro on your desktop. See Licensing Rational Desktop 
Products on page 23 for more information.

If the RequisitePro native client is accessing a RequisitePro database running Oracle, 
install Oracle client software on the native client. See Installing the Oracle Client on 
page 52. 

Note: You can create the database alias after you install the RequisitePro software.

Make sure you have administrator privileges on your desktop. See Administrator 
Privileges on page 26 for more information.

Ask your administrator for the correct deployment type. See Selecting a Deployment 
Type on page 37.

Check the system and software requirements for running RequisitePro on your 
desktop. See Desktop System and Software Requirements on page 27.

Installing RequisitePro

To install RequisitePro using one of the deployment options described in this 
chapter, see Installing Rational Products on page 59.

After Installation

See Rational RequisitePro – After Install on page 84 to learn how to connect to the 
RequisitePro database.
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Setting Up the RequisiteWeb Client

Use the checklist in Table 13 to configure the RequisiteWeb client on your desktop.

To use RequisiteWeb, you do not need:

� RequisitePro software on your desktop.

� Oracle client software on your desktop if you are using an Oracle database.

� A license key on your desktop or to specify a Rational license server. 

Preparing to Install Rational Rose

This section describes how you can install Rational Rose on your desktop. 

For the most current information related to Rose features and known issues, refer to 
the Rose Release Notes on the Rational Solutions for Windows Online Documentation CD. 
The release notes also appear at the end of the Rose installation and are available by 
clicking Start > Programs > Rational Software > Rational Rose > Rational Rose readme. 

Installing a Variant on the Same Desktop

If multiple variants of Rose are installed on a single Windows desktop, you can only 
run the last variant installed. For example, if you install Rational Rose Modeler Edition, 
and then install Rational Rose Professional J Edition, you can only run the Rose 
Professional J variant.

Table 13 RequisitePro Web client Installation Checklist

Done Task

Check with your administrator that the RequisiteWeb server is operating before 
you continue with this checklist.

To use RequisiteWeb, install one of the supported Web browsers on your desktop. 
See Desktop System and Software Requirements on page 27 for the supported Web 
browsers.

For proper RequisiteWeb operation, set your browser to allow cookies.

Log in to the RequisiteWeb. See Logging In to RequisiteWeb on page 87.
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Setting Up Rose on Your Desktop

Use Table 14 to help you install Rational Rose on your desktop. There are no 
post-installation procedures.

Adding the Rational Directory to Your User Path

When installing Rose on Microsoft Windows NT 4.0 SP6a or Windows 2000, Rose may 
not run until you add the Rational\Common directory to your user path. Use the 
following procedure to add the directory to your user path:

1 Click the Start > Settings and click Control Panel. 

2 Double-click the System icon and select the Environment tab. 

3 Click Path Variable in the User Variable section of the dialog box. 

4 In the beginning of the existing path, insert the Rational common path (typically, 
C:\Program Files\Rational\Common), and then click Set. 

5 Click OK to add the path and close the dialog box. 

Table 14 Rose Desktop Installation Checklist

Done Task

Before Installation

Get a license key to run Rose on your desktop. See Licensing Rational Desktop Products 
on page 23 for more information.

Make sure you have administrator privileges on your desktop. See Administrator 
Privileges on page 26 for more information.

Ask your administrator for the correct deployment type. See Selecting a Deployment 
Type on page 37.

Check the system and software requirements for running Rose on your desktop. See 
Desktop System and Software Requirements on page 27.

When installing Rose as part of Rational Suite on Microsoft Windows NT 4.0 SP6a or 
Windows 2000, Rose may not run until you add the Rational\Common directory to 
your user path. See Adding the Rational Directory to Your User Path on page 54 if you 
encounter this problem.

Installing Rose

To install Rose from one of the deployment options described in this chapter, see 
Installing Rational Products on page 59.
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Preparing to Install Rational Testing Products

Use Table 15 to install and configure Rational testing products on your desktop. To set 
up a Test Datastore and the ManualTest Web server, see the Installation Guide for 
Rational Server Products.

For the most current information related to Rose features and known issues, refer to 
the Testing Products Release Notes on the Rational Solutions for Windows Online 
Documentation CD. The release notes also appear at the end of the product installation 
and are available by clicking Start > Programs > Rational Software > Rational <testing 
product> > Rational <testing product> readme. 

Table 15 Rational Testing Desktop Installation Checklist

Done Task

Before Installation

Get the license keys to run your Rational testing products. See Licensing Rational 
Desktop Products on page 23 for more information.

Make sure you have administrator privileges on your desktop. See Administrator 
Privileges on page 26.

Read the descriptions of the Rational testing products in this section and check 
Desktop System and Software Requirements on page 27 for your product’s system 
and software requirements. 

Ask your administrator for the correct deployment type. See Selecting a 
Deployment Type on page 37.

If SQA Suite 6.x is installed on your computer, you do not have to remove it. The 
current version of Rational testing products and SQA Suite 6.x. can coexist 
because they are installed in different directories.

Make sure that all computers have TCP/IP installed. Install any updates to your 
network software that you have not installed.

Verify that the computers in your network are communicating with each other. (If 
you have any problems, see your network administrator.)

To install Rational Robot for distributed testing, see Installing Rational Robot for 
Distributed Testing on page 57.

Determine the role each computer plays in testing—whether it is a Local or an 
Agent computer. For information, see About Rational Test Agents on page 58.

To generate test scripts using the TUXEDO protocol, install the TUXEDO 6 client 
software on the Local computer before you install any Rational testing products.
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About Rational TestManager

Use Rational TestManager to manage all testing activities: planning, design, 
development, execution, and analysis. TestManager ties testing to the rest of the 
development effort, joining your testing assets and tools to provide a single point 
from which to understand the exact state of your project. TestManager includes the 
Rational Administrator, a project management tool. For information about how to use 
the Rational Administrator, see the Rational Suite Administrator’s Guide.

Install the appropriate database client software if you plan to play back test scripts 
on Local or Agent computers. See Installing Client Software for Performance Testing 
on page 59.

To use Robot to test .NET applications, install Robot on the test computer after 
you install the .NET platform.

During installation, Robot needs to install some assemblies to the global assembly 
cache. If you install Robot before you install the .NET framework, this step is 
skipped. You need to either re-install Robot or copy Dotnetspy.dll and 
interop.mscoreee.dll into your global assembly cache. 

Installing Rational Testing Products

To install Rational Testing Products from one of the deployment options described 
in this chapter, see Installing Rational Products on page 59.

After Installation

Determine the kind of network to use, either Ethernet or Token Ring. You must 
know this when you install the Rational Test network driver. See Installing and 
Removing the Network Driver on page 88.

Install the Rational Test Agents. See Installing Rational Test Agents on page 91.

If you plan to use Rational ManualTest Web Execution, see Accessing Rational 
ManualTest Web on page 95. The instructions for setting up the Web server are in 
the Installation Guide for Rational Server Products.

Install the Sample Applets. See Installing the Sample Applets on page 98.

Ask your administrator where you should store your test assets and artifacts. See 
About Rational Test Datastores on page 58.

Table 15 Rational Testing Desktop Installation Checklist

Done Task
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About Rational ManualTest Web Execution

A manual test script is a set of testing instructions that are run by a human tester. A 
manual test script can consist of steps and verification points that you type into a 
manual test script using Rational ManualTest. After you create a manual test script 
and associate it with a test case, creating a test case implementation, you can run the 
test case from a Web browser. For information about creating a manual test script and 
about test case implementations, see the Rational TestManager User’s Guide.

Note:  You can only run a test case from a Web browser if it has a manual test script 
implementation; you cannot run a test case with an automated test script 
implementation from a Web browser. If a test case has both a manual test script and an 
automated test script implementation, only the manual test script runs from a Web 
browser.

To run a test case associated with a manual test script, you or an administrator must 
install and configure a Web server with ManualTest Web Execution software and 
configure a Web browser on each desktop to access a Rational project. To configure the 
Web server, see the Before You Install and After Install: Configuring Test Datastores and 
Test Web Server chapters in the Installation Guide for Rational Server Products.

About Rational Robot

When you install Rational Robot, you install all of the following products: 

� Rational TestManager, which is described in the previous section.

� Rational Robot – Use to develop and execute functional and performance tests for 
your Windows applications. For information, see the Rational Robot User’s Guide.

� Rational Administrator – Use to manage a Rational project. For information, see 
the Rational Suite Administrator’s Guide.

� Rational SiteCheck – Use to manage Internet and intranet Web sites. For 
information, see the Rational SiteCheck Help.

� Comparators – Includes the Object Properties, Text, Grid, and Image Comparators. 
Use to view and analyze the results of test script playback. For information, see the 
Rational TestManager User’s Guide and the Comparators Help.

To use Robot to test .NET applications, install Robot on the test computer after you 
install the .NET platform.

Installing Rational Robot for Distributed Testing

To record GUI test scripts on multiple computers, install Robot on each computer. A 
separate node-locked license is required for Robot-only installations. For information 
about installing node-locked licenses, see Licensing Rational Desktop Products on 
page 23.
Chapter 1 - Before Install 57



rs_install_desktop.book  Page 58  Wednesday, April 16, 2003  4:52 PM
About Rational TeamTest

When you install Rational TeamTest, you can install some or all of the components 
available on your installation CDs. Rational TeamTest includes the following:

� Rational TestManager and Rational Robot, described previously.

� Rational ClearQuest – Use to track defects of your testing project. Robot installs 
ClearQuest, which includes specially designed defect forms.

� Rational Administrator is included in Robot and TestManager. For information 
about the Rational Administrator, see the Rational Suite Administrator’s Guide.

About Rational Test Datastores

A Rational Test Datastore stores functional and performance testing assets and 
artifacts such as suites, test plans, test cases, reports, test logs, and scripts, as well as 
information about users, groups, and computers. When you create a new test 
datastore from the Rational Administrator, you have the option of using two types of 
database engines: Microsoft Access or Sybase SQL Anywhere. For more information, 
see the Installation Guide for Rational Server Products.

The Rational Administrator, a project and data store management tool, is included in 
RequisitePro, Robot, SQL Anywhere, TestFactory, TestManager, and Rational Suite 
editions. For information about the Rational Administrator, see the Rational Suite 
Administrator’s Guide.

About Rational QualityArchitect

Rational QualityArchitect is a collection of integrated tools for testing middleware 
components such as Enterprise JavaBeans and COM. 

Rational QualityArchitect is fully integrated with Rational Rose, Rational 
TestManager, Rational Administrator, and Rational RequisitePro: Rational 
QualityArchitect lets you reverse-engineer a component into Rose; map Java 
packages, classes, and methods to requirements in RequisitePro; generate test scripts 
from Rose; and edit and run the test scripts right from your Java development 
environment.

About Rational Test Agents

After you install and license your Rational testing software on a Local computer, you 
have the option of installing Rational Test Agents on other computers. Use an Agent 
computer to:

� Add workload to the server, if you are running a performance test.
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� Run test scripts on more than one computer. If you are running a functional test, 
you can save time by running the test scripts on the next available Agent computer 
instead of running them all on the local computer.

� Test configurations. If you are testing various hardware and software 
configurations, you can run test scripts on specific Agent computers that are set up 
with these configurations.

For more information about installing Rational Test Agent software on Windows and 
UNIX computers, see Installing Rational Test Agents on page 91.

Installing Client Software for Performance Testing

To play back a test script that tests Oracle, Sybase, or SQL Server databases on a Local 
or Agent computer, install the appropriate database client software.

Oracle Client Software

To play back a test script that tests an Oracle database on a Local or Agent computer, 
install Oracle client software. 

Sybase Client Software

To generate test scripts that test a Sybase database, install the Sybase 11.1 NT client 
software on the Local computer, that is, the Windows 2000 Server or the Windows NT 
4 Server.

To play back test scripts that test a Sybase database, install the appropriate software 
on each Agent computer: 

� For UNIX Agents, install Sybase 11.1 UNIX client software

� For NT Agents, install Sybase 11.1 NT client software

SQL Server Client Software

To generate test scripts that test a SQL Server database, you must install the SQL 
Server 6.5 or newer NT client software on the Local computer. 

Note:  Datastores created on the client can be stored on separate servers that have 
Windows NT 4 or Windows 2000 operating systems with SQL software.

To play back SQL Server test scripts on an Agent, you must install the appropriate 
software on each Agent computer as follows: 

� For UNIX Agents, install Sybase 11.1 UNIX client software (limited compatibility)

� For NT Agents, install SQL Server 6.5 or newer NT client software
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TUXEDO Protocol Software

To generate test scripts using the TUXEDO protocol, install the TUXEDO 6 client 
software on the Local computer before you install any Rational testing products. 

SAP Protocol Software

To generate test scripts using the SAP protocol, you must install the SAP Front end 
software, typically referred to as SAPGUI, on the Local computer.

DCOM/COM+ Protocol Software

Before you play back test scripts that use the DCOM/COM+ protocol on an Agent 
computer, ensure that the client application recorded on the Local computer also runs 
on the Agent. This ensures that the necessary COM objects are present and properly 
registered on the Agent.

WebLogic/EJB Protocol Software

To generate test scripts that test a WebLogic/EJB server, you must install WebLogic on 
the appropriate Local computer.

To play back test scripts that test a WebLogic/EJB server, you must install WebLogic 
on the appropriate Local or Agent computer.

About Rational Test Enablers

The Rational Test Enablers consist of the following. For more information about the 
Rational Test Enablers, see the Rational Robot User’s Guide.

Rational ActiveX Test Control – Install to test the properties of the ActiveX controls in 
your application-under-test using Robot. 

Note:  If you are using a development environment other than PowerBuilder, Oracle 
Forms, Visual Basic, Delphi, Java, or HTML, and you want to test the properties of 
your ActiveX controls, you must manually add the Rational ActiveX Test Control to 
each OLE container in your application. For instructions, see the documentation that 
comes with your development environment.

The ActiveX Test Control provides communication between any OLE container and 
Robot. It is a nonintrusive control and has no impact on the behavior or performance 
of your application. At runtime, the Rational ActiveX Test Control is not visible. 

Rational Test Java Enabler – Required to test Java applets running in a browser, or to 
test stand-alone Java applications. This Enabler scans your hard drive for Web 
browsers and Sun JDK installations that Robot supports and enables only those 
environments currently installed on your system. Run the enabler each time you 
install a new Java environment (such as a new release of a browser or JDK).
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Rational Test Oracle Forms Enabler – Install to test Oracle Forms 6.0, 5.0, and 4.5 
applications. Installs both the Rational Test Oracle Forms Enabler and the 
Rational Test Object Testing Library for Oracle Forms. 

Note:  Be sure to install Oracle Forms 6.0, 5.0, or 4.5 and the Oracle Open Client 
Adapter for ODBC before you install the Rational Test Oracle Forms Enabler.

Rational Test Delphi Enabler – Install to test your Delphi applications. Before you can 
test your Delphi applications, you must install the Rational Object Testing Library for 
Delphi and the Rational Test Delphi Enabler.

Rational Test Visual Basic Enabler – Install to test Visual Basic 4.0 applications. 
Ensures that all forms in your project, including MDI forms, contain the Rational 
ActiveX Test Control. This Enabler is an add-in (extension) to Visual Basic 4.0. For 
more information about Visual Basic add-ins, see your Visual Basic documentation. 

Note:  You do not need the Visual Basic Enabler to test Visual Basic 5.0 and later 
applications.

About Rational XDE Tester

XDE Tester is the newest version of the product introduced as Rational RobotJ in 
Rational Suites Enterprise Studio, Rational Suites TestStudio, and Rational TeamTest 
version 2002.05.02. XDE Tester includes all the RobotJ functionality.

If you are upgrading RobotJ to XDE Tester, see the Rational Suite Upgrade Guide for 
important upgrade information.

For installation procedures, see the printed Installation Guide for Rational XDE Tester 
in your media kit.

Preparing to Install Rational XDE Modeler and XDE Developer

Rational XDE Modeler and XDE Developer provide visual design and development 
tools tightly integrated with Microsoft Visual Studio .NET, IBM WebSphere, and the 
Eclipse platform.

For installation procedures, see the printed Release Notes for XDE Modeler and XDE 
Developer in your media kit.
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2Installing Rational 
Products
Use the Rational Setup Wizard for initial and upgrade installations of Rational 
desktop client installations. This chapter describes how the Rational Setup Wizard can 
help you install Rational products on client desktops using the methods described in 
Selecting a Deployment Type on page 37.

Note:  See the Installation Guide for Rational Server Products for more information 
about installing and configuring server software, setting up network release areas, 
creating site defaults files, and running silent installations.

Removing Previous Releases of Rational Products

Before installing Rational products from version 2003.06.00, remove previous versions 
of Rational products, including the Rational license server. The only exception is 
Rational ClearCase. You can install 2003.06.00 products with older versions of 
ClearCase. 

For the removal procedure, see the Removing Rational Products chapter in this guide. 

You or your system administrator must see the Rational Suite Upgrade Guide in the 
Rational Solutions for Windows Online Documentation CD-ROM before you try to 
upgrade your Rational products.

Note:  If you are using floating licenses, record the license server name(s) before you 
remove Rational products from your computer. After you install new Rational 
products on your computer, reset the hostnames in the Rational License Key 
Administrator. For more information, see the Removing Rational Products chapter in 
this guide.
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Deploying Rational Products

Use Table 1 to help you find the correct procedures for the deployment method that 
your administrator has selected for you. If the references are numbered, read the 
sections in the order specified.

Table 1 Installation Tasks

Method See

Install directly from the Rational Solutions 
for Windows CD.

1 Using the Rational Setup Wizard on page 65.

2 Using the Custom Setup Page on page 66.

3 Specifying the Rational License Server on page 68.

4 Installing Rational Products from the CD on 
page 68.

5 Post-Installation Tasks on page 75.

Install from a release area on a network 
(using the standard configuration)

1 Installing Products from a Release Area on 
page 70.

2 Post-Installation Tasks on page 75.

Install from a release area on a network 
(customizing the client configuration for 
your desktop)

1 Installing Products from a Release Area on 
page 70.

2 Using the Custom Setup Page on page 66.

3 Post-Installation Tasks on page 75.

Run a silent installation from a site defaults 
file.

1 Using Silent Installation Commands on page 73.

2 Post-Installation Tasks on page 75.

Removing a product. � Removing Rational Products on page 105. Or,
� Using the Command Line to Remove a Product on 

page 75.

Cancel a product installation. � Canceling a Product Installation on page 77. Or, 
� Canceling a Silent Installation on page 75.

Reinstall a product (modify or repair). Reinstalling a Product (Modify or Repair) on 
page 77.

Apply a service release. Applying Service Releases on page 78.
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Using the Rational Setup Wizard

The Rational Setup Wizard installs Rational Software products. Your Rational product 
shipment includes three Rational Solutions for Windows CDs: 

� Disc 1-2 provide the Rational products to install. 

� Disc 3 provides Rational product documentation.

Rational_Install Log

The Setup Wizard does not display an error summary. The log of installation activities 
called Rational_install.log records all installation activities. You and a Customer Support 
representative can use the log to trace any installation errors.

By default, the install log file is in the TEMP directory. The location of the directory 
depends on the TEMP environment variable set on the computer. To find the location, 
open a command Window and type echo %TEMP% at the DOS prompt. 

This folder and file may be hidden. To display them in Windows Explorer, set Show 
Hidden Files and Folders.

Before You Start the Rational Setup Wizard

The following general requirements are necessary to run the Rational Setup Wizard 
on the system.

� Stop all applications, including SQL Anywhere services, before you begin the 
installation.

� Make sure you have administrator privileges before installing Rational products. 

To use the Rational Setup Wizard on a Windows operating system, you must have 
Windows administrator privileges on the local computer. Log in as one of the 
following users:

❑ Local administrator

❑ Member of the local administrator’s group

❑ Domain administrator who is a member of the local administrator ’s group

� Turn off all virus protection software. These programs often run in the background 
and interfere with the install application’s performance because the virus 
protection checks each file that is installed.

� Make certain that the system meets the minimum requirements and the correct 
operating system.
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� The Rational Setup Wizard uses C:\Program Files\Rational as the default installation 
path.

� The Rational Setup Wizard installs Microsoft Core Components and some 
additional files on the same drive as the operating system (often the C:\ drive), 
even if you have specified an alternate drive for installation. These files can require 
5-15 MB of temporary disk space on your hard drive.

� The Rational Setup Wizard requires that you install all Rational products in the 
same directory. If you already have Rational products installed on the computer, 
the Setup Wizard installs additional Rational products in the same directory. 

� Make sure that you have a current backup of your registry and system directories. 

� Turn off any user interface managers or environments that run on Microsoft 
Windows.

Using the Custom Setup Page

Use the following table to help you install the Rational client software for the 
following products, if you are installing:

� From the Rational Solutions for Windows CD, or 

� From a release area and do not accept the defaults set by your administrator. If you 
do accept the site defaults in the file, skip this section.

Note:  For disk space requirements, see the Desktop System and Software Requirements 
on page 27. Do not use the number displayed in Custom Setup or the Space button on 
that page.
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Select Product Custom Setup Notes

ClearCase LT ClearCase LT > 
� Rational ClearCase 

Microsoft Visual 
Studio.NET

Install the ClearCase LT client software only. 

ClearQuest ClearQuest 

See Notes.

Deselect the features that are selected on the 
Custom page so you install the basic 
ClearQuest software on your computer.

RequisitePro RequisitePro > 
� Database Setup
� Sample Projects
� Web Server Components > 

Rational RequisiteWeb

Install the components that are already 
selected on the Custom Setup page.

Robot Robot > 
� Web Server Components
� TestManager
� Rational Extended Help

The Web Server Components feature are 
deselected. Select the Web Server 
Components only if you are installing the 
Web server for ManualTest Web Execution. 
See the Installation Guide for Rational Server 
Products for instructions.

TeamTest TeamTest > 
� ClearQuest
� Test Samples Setup
� Robot
� Rational Extended Help
� Web Server Components

The Web Server Components feature are 
deselected. Select the Web Server 
Components only if you are installing the 
Web server for ManualTest Web Execution. 
See the Installation Guide for Rational Server 
Products for instructions.

TestManager TestManager >
� Web Server Components

The Web Server Components feature are 
deselected. Select the Web Server 
Components only if you are installing the 
Web server for ManualTest Web Execution. 
See the Installation Guide for Rational Server 
Products for instructions.
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Specifying the Rational License Server

You can provide a Rational license server name in the Rational Setup Wizard if you 
are using floating licenses. Your administrator may have already provided the license 
server name if you are installing from a release area or running a silent installation. If 
your product does require a license key and you or your administrator do not provide 
the name, the Rational License Key Administrator (LKAD) launches at the end of the 
installation.

Installing Rational Products from the CD

This section describes a typical installation of a desktop product or client software 
from the CD. The Rational Setup Wizard guides you through the software installation. 
Click Next to launch the installation, and to advance through the following screens.

Note:  Interrupting an installation that is in progress may leave your computer in an 
indeterminate state. If you try to close the Rational Setup Wizard window while the 
installation is in progress, you are asked to confirm that you want to exit from the 
incomplete installation.

To install desktop products from a CD:

1 Log in as a user with administrator rights on the local machine on which you want 
to install the product.

2 Insert the Rational Solutions for Windows Disc 1 into the computer ’s CD drive. 

The Rational Setup Wizard starts automatically.

If autorun is disabled on your computer, click Start  >  Run and enter 
cd_drive: \Setup.exe where cd_drive is the letter of the CD drive.

3 The Product Selection page lists all products available for installation. Select the 
product you want to install.

4 Select the Desktop Installation from CD Image option in the Deployment Method 
page.

5 If you are installing ClearCase LT, you will see the Client/Server page. The client 
software on the client computers will not work until you have installed and 
configured the server.

❑ If you are installing and configuring the server software, select Install the server 
and client software. 

❑ If you are installing client software, select Install the client software only.
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6 Choose to accept or not to accept the Rational Software license agreement in the 
License Agreement page. 

❑ If you accept the license agreement, the installation Wizard continues. 

❑ If you do not accept the license agreement, exit the Setup Wizard by clicking 
Cancel and then Finish. For information about changes to the computer, see 
Canceling a Product Installation on page 77.

7 The Destination Folder page specifies the directory where the Wizard will install 
the Rational product. If you want to change the location, click Change.

Note:  The installation Wizard requires that all Rational products be installed in the 
same directory.

8 The Custom Setup page provides product feature options for the software 
installation. You can either accept the default features on the page or you can 
customize the installation. See Using the Custom Setup Page on page 66 to verify if 
you need to customize the installation.

If you want to change the features, use the Help.

Note:  For disk space requirements, see Desktop System and Software Requirements on 
page 27. Do not use the number displayed in Custom Setup or the Space button on 
that page.

9 Depending on the product that you have selected, you will see one or more custom 
configuration pages in the wizard. Use the Help to provide instructions in this 
section of the wizard.

Enter the required information in each page of the wizard. (All required 
information displays in the left panel of the wizard with a red dot.) 

To navigate through the pages, you can either click Next to see them sequentially 
or click on the page title in the left pane to access the page directly and 
nonsequentially.

When you complete the last page, click Done.

10 Click Install on the Ready to Install the Program page to begin the installation.

11 A Restart Windows page appears if the Rational Setup Wizard needs to restart your 
computer. If files required for the installation are in use during the Rational Setup 
Wizard and if the Wizard needs to install shared components on your computer, 
the Setup Wizard may need to restart your computer. 

Select Restart or Don’t Restart. If you select Don’t Restart, the Wizard reminds you 
that the installation cannot complete until Windows restarts.

After Windows restarts, the second part of the installation process starts 
automatically after you log on. 
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12 When the Setup Complete page appears, we recommend that you review the 
current information related to new features and known issues in the readme file. In 
addition, you can view the Rational Developer Network Web pages. Click Finish to 
complete the installation.

Installing Products from a Release Area

When you are installing Rational products on a desktop from a release area 
designated by your system administrator, in most cases, we recommend that you 
accept the defaults as presented on the installation screens. Speak to your 
administrator if you want to change the defaults chosen for you. 

Installing from a release area includes the following tasks:

1 Your administrator creates one or more site defaults files in a release area using the 
Rational Setup Wizard (Enterprise Deployment option) or the Site Preparation 
Wizard and informs you of the name of the site defaults file and network location 
of the release area or sends you a shortcut to the site defaults file. 

Note:  The instructions for setting up a release area and populating it with site 
defaults files are in the Installation Guide for Rational Server Products.

2 Then, navigate to the release area and execute the site defaults file or execute the 
site defaults shortcut from your desktop client. This shortcut will run an 
installation on your desktop from the release area.

To install products from a release area, you can either use a standard configuration 
(the definitions set by your administrator), or you can customize the configuration for 
your desktop. The first section, Using a Standard Configuration on page 70, describes 
the procedure for using a standard configuration. The second section, Customizing 
Your Own Configuration on page 72, describes the procedure for customizing your 
configuration.

Using a Standard Configuration

Before following these instructions, read the overview information in the previous 
paragraphs. You or your administrator must create a release area and a site defaults 
file before you can install a product from the release area. 

To install a default configuration from the release area:

1 Log on as a user with local administrator privileges.

2 To install a Rational product using the settings in a specific site defaults file, either 
specify the name of the site defaults file on the command line or click the 
associated site defaults shortcut in the release area. For example, to install 
ClearQuest using the settings in sitedefs_cqclient.dat, map a network drive from 
your computer to the shared release area. Then, 
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❑ In the DOS Windows, use the cd command to navigate to the root directory of 
the release area. Then enter, for example, setup.exe sitedefs_cqclient.dat, or

❑ In Windows Explorer, expand the mapped drive and launch the shortcut, for 
example, sitedefs_cqclient.link or sitedefs_cqclient.

3 The Rational Setup Wizard guides you through the software installation. 
In each page, click Next to open the next page. Click Help for more information.

❑ The License Agreement page displays the Rational Software license agreement. 
If you accept the license agreement and click Next, the installation continues. 

❑ If you do not accept it, the installation does not let you proceed further. Click 
Cancel and exit from the installation. You will not see any visible changes to the 
system. The program returns your system to the state it was in before you 
launched the Rational Setup Wizard.

Note:  If you do not have the correct version of Windows Installer software on 
your computer, the Rational Setup Wizard will install it for you. Canceling the 
installation does not remove the updated version of Windows Installer. In some 
cases, you may have to restart the computer. 

4 The Destination Folder page displays the default destination folder for the 
installation. Click Change to select a different destination folder for the installation. 
Click Next.

5 Click Use the standard configuration on the Site Default Configuration page. The 
default features for the product and the existing site default values will be used for 
the client installation. Click Next.

6 Click Install to begin the installation on your client desktop.

7 A Restart Windows page appears if the Rational Setup Wizard needs to restart your 
computer. If files required for the installation are in use during the Setup Wizard, 
and if the Wizard needs to install shared components on your computer, the Setup 
Wizard may need to restart your computer. 

Select Restart or Don’t Restart. If you select Don’t Restart, the Wizard reminds you 
that the installation cannot complete until Windows restarts.

After Windows restarts, the second part of the installation process starts 
automatically after you log on. 

8 When the Setup Complete page appears, we recommend that you review the 
current information related to new features and known issues in the readme file. In 
addition, you can view the Rational Developer Network Web pages. Click Finish to 
complete the installation.
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Customizing Your Own Configuration

Before following these instructions, read the overview of installing a product from a 
release area in this section. You or your administrator must create a release area and a 
site defaults file before you can install a product from the release area. 

To customize a configuration for a specific computer:

1 Log on as a user with local administrator privileges.

2 To install a Rational product using the settings in a specific site defaults file, either 
specify the name of the site defaults file on the command line or click the 
associated site defaults shortcut in the release area. For example, to install 
ClearQuest using the settings in sitedefs_cqclient.dat, map a network drive from 
your computer to the shared release area. Then, 

❑ In the DOS Window, use the cd command to navigate to the root directory of 
the release area. Then enter, for example, setup.exe sitedefs_cqclient.dat, or

❑ In Windows Explorer, expand the mapped drive and launch the shortcut, for 
example, sitedefs_cqclient.link or sitedefs_cqclient.

3 The Rational Setup Wizard runs and guides you through the software installation. 
In each page, click Next to open the next page. Click Help for more information.

4 The License Agreement page displays the Rational Software license agreement. 

❑ If you accept the license agreement and click Next, the installation continues. 

❑ If you do not accept it, the installation does not let you proceed further. Click 
Cancel and exit from the installation. You will not see any visible changes to the 
system. The program returns your system to the state it was in before you 
launched the Rational Setup Wizard.

Note:  If you do not have the correct version of Windows Installer software on 
your computer, the Rational Setup Wizard will install it for you. Canceling the 
installation does not remove the updated version of Windows Installer. In some 
cases, you may have to restart the computer. 

5 The Destination Folder page displays the default destination folder for the 
installation. If you want to select a different destination folder for the installation, 
click Change. 

6 Click I will create my own custom client configuration on the Site Default 
Configuration page.
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❑ The Custom Setup page displays product features to select. For more 
information about features for your product, see Using the Custom Setup Page 
section in this chapter. 

Note:  For disk space requirements, see the System and Software Requirements 
table in the Before You Install chapter of this guide. Do not use the number 
displayed in Custom Setup or the Space button on that page.

❑ When you click Next, you may change any of the existing site default values. 
(Any changes to the site default values apply only to this single installation.) 
After modifying the values, click Done.

7 Click Install to begin the installation on your client desktop.

8 A Restart Windows page appears if the Rational Setup Wizard needs to restart your 
computer. If files required for the installation are in use during the Setup Wizard 
and if the Wizard needs to install shared components on your computer, the Setup 
Wizard may need to restart your computer. 

Select Restart or Don’t Restart. If you select Don’t Restart, the Wizard reminds you 
that the installation cannot complete until Windows restarts.

After Windows restarts, the second part of the installation process starts 
automatically after you log on. 

9 When the Setup Complete page appears, we recommend that you review the 
current information related to new features and known issues in the readme file. In 
addition, you can view the Rational Developer Network Web pages. Click Finish to 
complete the installation.

Using Silent Installation Commands

A silent installation lets you install a Rational Software product, using the same 
parameters, repeatedly on a number of computers.

Silent Installation Overview

Your administrator may set up a site defaults file so that many users can perform 
unattended installations of a Rational Software product with the same parameters. 

The site defaults file directs the Rational Setup Wizard to install program files in a 
specific directory on your computer. For information about setting up a silent 
installation, see the Installation Guide for Rational Server Products.

When you start the silent installation, you do not see any installation screens. If a 
restart is required, your computer restarts automatically. After the computer restarts, 
you must log on manually. The install wizard then re-launches automatically and 
finishes. When the installation finishes, you do not see an installation complete screen 
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at the end. If your administrator did not specify the license server in the site defaults 
file or you are using a node-locked license key, you may have to manually configure 
licensing after the Setup Wizard finishes. For more information, see Licensing Rational 
Desktop Products on page 23.

Running a Silent Installation

The following instructions describe the commands you need to run a silent 
installation on your computer.

To run the silent installation on your desktop, your administrator gives you the 
following information:

� Path to the site defaults file and the setup.exe executable in the release area or 
shortcut to the site defaults file. (The shortcut will not have a .dat suffix.)

� Installation directory (where the Rational Setup Wizard will install the files on 
your desktop).

� License key information, if necessary.

� Ensure that you have removed all previous versions of Rational products from 
your desktop. Users who install silently do not see the warning message to remove 
previous versions of Rational products. The installation does not proceed until all 
products are removed. This warning message is saved in you installation log file. 
See this file if the installation fails. For more information about this file, see 
Rational_Install Log on page 65.

To run the site defaults file in silent mode:

1 Map a local drive to the release area (optional).

2 Go to Start > Run and enter the following commands:

<local drive>: \setup.exe /g <C:\filename.dat>

Where <local drive> is the mapped drive or the path to setup.exe. There is a space 
between setup.exe and command /g and a space between /g and the path to the 
filename.dat file which is C:\:filename.dat.

The executable installs the product specified in the site defaults file from the 
source directory to the installation path. The default installation path is C:\Program 
Files\Rational\<Rational products>. 

If a restart is required, your computer restarts automatically. After the restart, you 
must log on manually. The installer then re-launches automatically and finishes. 
When the installation finishes, you do not see an installation complete screen. 
74 Installation Guide for Rational Desktop Products 



rs_install_desktop.book  Page 75  Wednesday, April 16, 2003  4:52 PM
If your administrator did not specify the license server in the site defaults file, you 
may have to manually configure licensing after the Setup Wizard finishes.

Note:  If the Rational Setup Wizard detects insufficient disk space on the desktop, 
the Wizard will cancel the installation and note the error in the Rational_install.log in 
your TEMP directory. The location of the directory depends on the environment 
variable set on the computer. To find the location, open a command Window and 
type echo %TEMP% at the DOS prompt.

Canceling a Silent Installation

There is no command to cancel a silent installation.

Using the Command Line to Remove a Product

To remove a Rational product in the current releases (2003.06.00), use the following 
commands. These commands will not remove earlier versions of Rational products.

<local drive>:\msiexec.exe /X <path to product>.msi /qn

Where <local drive>:\ is a mapped drive or path to msiexec.exe. The variable <path to 
product>.msi, such as ClearQuest.msi, is the path to the MSI file in your 
network-wide release area used by ClearQuest, for example, during installation. In 
the release area, that MSI file exists in the Setup directory. The command /x 
indicates an uninstall operation and /qn indicates no user interfaces are displayed 
during the uninstall operation.

Post-Installation Tasks

The following sections apply to all deployment types.

Licensing

If you do not see the License Key Administrator (LKAD) launch at the end of the 
installation, your product is either licensed or does not require a license. Skip to 
Product Installation Checklist on page 76. 

You may see the License Key Administrator (LKAD) launch at the end of a product 
installation for the following reasons:

Deployment Type Reason

Desktop installation from CD 
image

� You did not provide a Rational license server name in the 
Rational Setup Wizard, or

� The product requires a node-locked license key.
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If you see the LKAD, you must perform the following tasks to license the product.

Product Installation Checklist

Perform the post-installation tasks for the product you have just installed. If you are 
unsure whether the product requires any configuration, see Before Install on page 21 
and look for the product’s installation checklist.

Install from a Release Area 
(Enterprise Deployment)

� Your administrator did not provide a Rational license 
server name in the site defaults file, or

� The product requires a node-locked license key.

Silent Installation � Your administrator did not provide a Rational license 
server name in the site defaults file, or

� The product requires a node-locked license key.

To Configure Task See

Floating License Key Enter the name of the 
Rational license server in the 
LKAD.

� Licensing Rational Desktop Products on 
page 23, or

� Rational Software License Management 
Guide, or

� LKAD Help

Node-Locked 
License Key

Import the node-locked 
license key in the LKAD.

� Licensing Rational Desktop Products on 
page 23, or

� Rational Software License Management 
Guide, or

� LKAD Help

Deployment Type Reason
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Canceling a Product Installation

If you click Cancel any time during the installation procedure or before the 
installation completes, you will not see any visible changes to the system. The 
program returns your system to the state it was in before you launched the Rational 
Setup Wizard.

Note:  If you do not have the correct version of Windows Installer software on your 
computer, the Rational Setup Wizard will install it for you. Canceling the installation 
does not remove the updated version of Windows Installer. In some cases, you may 
have to restart the computer. 

Reinstalling a Product (Modify or Repair)

If you have sucessfully completed a previous installation of a Rational product in 
version 2003.06.00, you can modify or repair the installation by using Add or Remove 
Programs.

To remove the Rational product, see the chapter Removing Rational Products.

1 Log in as a user with Administrator rights on the local computer on which you 
want to install the product.

2 Click Start > Settings > Control Panel > Add or Remove Programs.

3 Highlight the Rational product and click Change.

❑ Modify the Existing Installation – Choosing this option enables you to change 
which products and product features are installed. The Setup Wizard provides 
the Custom Setup page for you to clear or select features. For example, you 
included the ClearQuest Multisite Administration Tools in your ClearQuest client 
installation. To reinstall the ClearQuest client, clear this product feature in the 
Custom Setup page and reinstall the ClearQuest client.

Click Modify and then click Next to select or clear features in the Custom Setup 
page. Click Next and then click Install to begin the installation.

❑ Repair the Existing Installation – Choosing this option enables you to repair a 
damaged registry or replace files that you may have inadvertently deleted. This 
option does not repair incomplete or unsuccessful installations.

To begin the repair, click Repair and then click Next and then click Install. At the 
end of the operation, the status of the repair is displayed.
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Rational Setup Wizard Warnings or Blocks

If you encounter blocks or warnings during the installation procedure, consult the 
following table if you do not remember the entire message.

Applying Service Releases

The basic steps for obtaining a Rational service release are:

1 Install the Rational Download Manager client software on your computer. 

There are two sources from which you can download the Rational Download 
Manager installer.

Warning/Block Solution

You are attempting to install on an 
unsupported operating system. 

We recommend that you install on a 
supported operating system. Your Rational 
product's Release Notes for a complete list of 
supported operating systems and service 
packs.

You are attempting to install on a system with 
an unsupported browser. 

See your Rational product's Release Notes for 
a complete list of supported browsers before 
using Rational Unified Process, 
ProjectConsole, Rose, Web Publisher, and 
XDE Web Publisher.

You are attempting to install on a system that 
has an version of Office that is not compatible 
with SiteCheck.

See your Rational product's Release Notes for 
a complete list of supported versions.

You are attempting to install on an 
unsupported version of WebSphere Studio.

It is recommended that you utilize a 
supported version. Please refer to the Release 
Notes for the complete list of supported 
operating systems.

MDAC and ODBC If the correct MDAC and ODBC drivers are 
not installed on your computer, the Setup 
Wizard installs version 2.7 of the Microsoft 
Data Access Components (MDAC) and Open 
Database Connectivity (ODBC) drivers. For 
more information, read Microsoft Knowledge 
Base Article 216149.
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❑ From the Rational Solutions for Windows Disc 2. Locate the Rational Download 
Manager setup.exe and Readme.html in the Rational Extras folder. The 
Readme.html contains the installation procedure.

❑ From the Rational Download Center at 
www.rational.com/support/downloadcenter/about_dlm.jsp. You must either login or 
register as a member before you can download the software.

You can either save the file to a local drive on your computer or install Rational 
Download Manager directly from the Rational Download Center by clicking Open 
in the File Download dialog box.

2 Use your browser to go to: www.rational.com/docs/v2003/readme_v2003.html for 
service release documentation. The documentation provides service release 
features, restrictions, and instructions.

3 Use the Rational Download Manager to download the service release mechanism 
from this web site.

4 Install the Rational service release.
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3After You Install
The procedures in this chapter cover client configuration after installing Rational 
ClearCase LT, Rational ClearQuest, Rational RequisitePro, and Rational Testing 
products as standalone products and as part of Rational Suite. The product 
installation checklists in Before Install on page 21 provide product-specific lists of these 
tasks.

Rational ClearCase LT – After Install

Follow the steps in this section to configure a ClearCase LT native client. If you are 
using ClearCase Web, see Logging in to ClearCase Web on page 82.

Note:  The ClearCase LT server includes ClearCase LT client software, so these steps 
apply to the server as well.

Creating Views

You need to create views before users can access data on the ClearCase LT server. 
How you create them depends on whether your site will be using the Rational Unified 
Change Management (UCM) or base ClearCase.

To create a development and an integration view in UCM: 

1 Click the Rational ClearCase LT icon on your desktop to start ClearCase Explorer. 

2 Click the Toolbox tab, click the UCM bar, and then click the Join Project icon to run 
the Join Project Wizard.

To create a view in base ClearCase: 

1 Click the Rational ClearCase LT icon on your desktop to start Clearcase Explorer.

2 Click the Toolbox tab, select the Base ClearCase bar, and then click the Create View 
icon.
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Logging in to ClearCase Web

To access ClearCase Web:

1 Ask your administrator for the ClearCase LT server name.

2 Start your Web browser, and then enter the following URL:

http://<server name>/ccweb

where <server name> is the host name of the ClearCase LT server machine.

3 Press RETURN. No log on information is required.

Rational ClearQuest – After Install

Follow the procedures in this section to configure the ClearQuest native client 
(Table 1) or configure the ClearQuest Web client (Table 2) on your desktop. 

Table 1 After Install: ClearQuest Native Client

Task See

Create a database alias. � Creating a DB2 Database Alias on page 83.
� Creating an Oracle Database Alias on page 84.

Connect to the ClearQuest database. Connecting to ClearQuest Databases on page 84.

Log in to ClearQuest. Logging In to ClearQuest on page 87.

Configure ClearQuest client to send 
and receive e-mail notification.

� Configuring Your ClearQuest Client to Receive 
E-Mail Notification on page 87

� Configuring Your ClearQuest Client to Send E-Mail 
Notification on page 87.

Table 2 After Install: ClearQuest Web Client

Task See

Log in to ClearQuest Web. Logging In to ClearQuest on page 87.

Configure Web client for e-mail 
notification.

Configuring Your ClearQuest Web Client To Receive 
E-Mail Notification on page 89.

Use the Advanced Query editor (optional). Using the Advanced Query Editor on page 89.
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Creating a DB2 Database Alias

Before using a ClearQuest Windows client to access a ClearQuest DB2 database, you 
must use the Client Configuration Assistant to create database alias for each physical 
ClearQuest database you will use. The administrator will assign a specific database 
alias name to use when creating the DB2 database alias.

1 For DB2 7.x, click Start > IBM DB2 > Client Configuration Assistant. For DB2 8.1, 
click Start > IBM DB2 > Set-up Tools > Configuration Assistant.

2 For DB2 7.x, in the Welcome dialog box, click Add database. For DB2 8.1, in the DB2 
Message dialog box, click Yes. Then, click Search the network and click Next.

3 Expand the Known Systems folder. If you see the DB2 database server host on 
which the ClearQuest database resides, expand it and select the database name for 
which you want to create an alias. Click Next.

Note:  If you do not see the DB2 server computer you need, expand the Other 
Systems folder. If you still do not see the computer, talk to your ClearQuest 
database administrator. There may be a network problem.

4 Type an alias name in the Database alias box. Type an optional comment in the 
Comment box and click Next.

5 Clear the Register this database for ODBC option if it is selected. Click Finish.

6 A confirmation dialog box opens. To test access to the DB2 database, click Test 
Connection and type the user name in the User ID box and password in the 
Password box.

If the connection fails, attempt to connect by using the following command:

db2

db2> catalog TCPIP node node-name remote host-name server port-number

db2> catalog database database-alias at node node-name

db2> terminate

When a ClearQuest client uses the ClearQuest Maintenance Tool to create a schema 
repository or to configure the connection to the DB2 database server, the Database 
alias, created when using the DB2 client, is entered in the Database Alias box on the 
Maintenance Tool.
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Creating an Oracle Database Alias

To configure a ClearQuest client running on Windows to access a ClearQuest Oracle 
database, you must use the Net8 Assistant program to create a database alias for each 
physical ClearQuest database you will use. Contact your administrator for the specific 
database alias name to use when creating the Oracle database alias.

1 Click Start > Oracle - OraHome81 > Network Administration > Net8 Assistant.

2 In the navigation pane, expand Net8 Configuration, click Local, and then select 
Service Naming.

3 Click Edit > Create and complete the New Name Service Wizard:

a Type the name of the alias in the Net Service Name box. Click Next.

b Click TCP/IP to select the network protocol to use to communicate with the 
database. Click Next.

c Type the name of database server host in the Host Name box and type the port 
number in the Port Number box.

d Type the service name in the Service Name box and select the Oracle8i 
Connection Type. Click Next and then click Test. If the test of the connection 
succeeds, click Finish.

When a ClearQuest client uses the ClearQuest Maintenance Tool to configure a 
schema repository or a connection to the Oracle database server, the Net Service Name, 
which is created using the Oracle client, is entered in the SQL*Net Alias box on the 
Maintenance Tool.

Connecting to ClearQuest Databases

After installing the ClearQuest Windows client, you will need to connect to an 
existing schema repository. Your ClearQuest administrator has two methods of 
providing you with the database properties information:

� The ClearQuest administrator can provide you with the database properties for 
the schema repository and you can create a new connection (see Creating a New 
Connection on page 85).

� The ClearQuest administrator can create a connection profile for client users to 
connect to the schema repository (see Using Connection Profiles on page 86 and 
Importing a Connection Profile on page 86).

Note:  If your ClearQuest database is using Oracle or DB2, install the respective client 
software and create database aliases before connecting to ClearQuest. For more 
information, see Installing the Oracle Client or the DB2 Client on page 46 and Creating a 
DB2 Database Alias on page 83 or Creating an Oracle Database Alias on page 84.
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Creating a New Connection

Before you continue with these instructions, consult with your ClearQuest site 
administrator for this database property information.

1 Click Programs > Rational Software > Rational ClearQuest > ClearQuest 
Maintenance Tool.

2 Click Connection > New.

3 In the Existing Connections area, name the alias by typing a name in the 
highlighted item.

4 In the Schema Repository Properties group box, specify the properties of the 
vendor database designated for the schema repository. Select a vendor database 
from the drop-down list and type the required vendor database properties.

Database Properties

MS_ACCESS Type the entire path to the schema repository using a UNC style path. For 
example:

\\DevServer\ProjectShare\CQ_DBS\schema_repo.mdb

You can browse to the directory containing the database. Be sure to browse using 
the Network Neighborhood to preserve the UNC style path name.

SQL_ANYWHERE � Type the path to the schema repository using a UNC style path. For example:

\\DevServer\ProjectShare\CQ_DBS\schema_repo.mdb

You can browse to the directory containing the database by using Network 
Neighborhood, which preserves the UNC style path name. To do so:

� Type the name of the database server.
� Type the protocols used to communicate with the SQL Anywhere server.
� Type the database host name.
� Set the Connect Options.

SQL_SERVER � Type the SQL Server database name for the database containing the schema 
repository. 

� Type the name of the database server.
� Type the schema repository or read-only user login.
� Type the password for the schema repository or read-only login.

ORACLE � Type the SQL*Net Alias (alias pointing to the Oracle instance).
� Type the Oracle login created for the schema repository.
� Type the password for the login.
� Type the connect options for HOST, SID, SERVER_VER, CLIENT_VER, and 

LOB_TYPE.
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5 Click Finish to complete the connection.

Using Connection Profiles

Your ClearQuest administrator can create connection profiles that can be used as 
shortcuts.

Both ClearQuest administrators and ClearQuest client users can import and export 
connection profiles for later use.

Use the ClearQuest Maintenance Tool to export and import connection profiles.

Importing a Connection Profile

To use a previously created connection profile, you need to import a connection 
profile. 

1 From the Start menu, click Programs > Rational Software > Rational ClearQuest > 
ClearQuest Maintenance Tool.

2 Click File > Import Profile.

3 In the Import Profile Information area, type the path and file name of the profile you 
would like to import.

Note:  After completing a ClearQuest client installation from a release area, when 
the Import page displays, the default location of the profile (that was defined 
using the Site Preparation Wizard) is pre-populated in the Import Profile 
Information area.

4 Click Next.

5 Click to select the connections to import and verify the Schema Repository 
Properties information, then click Finish.

DB2 � Type the Database Alias name (Database Alias pointing to the DB2 database).
� Type the DB2 login created for the schema repository.
� Type the password for the login.

Database Properties
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Logging In to ClearQuest

After you create a new connection to a schema repository using the ClearQuest 
Maintenance Tool, you can login to the schema repository and select the user database 
you want to access.

Before you can login, your ClearQuest administrator must provide you with a user 
name and password. 

To login:

1 Click Start > Programs > Rational Software > Rational ClearQuest > ClearQuest.

2 If you have created connections to more than one schema repository, select a 
schema repository from the Rational ClearQuest Schema Repository dialog and 
then click Next.

3 Type your user name and password and then select a user database and then click 
OK. The ClearQuest client opens and you can begin to use ClearQuest.

Note:  If you open a Warning - Invalid Login dialog box, click the Details option in this 
dialog for further information.

Configuring Your ClearQuest Client to Receive E-Mail Notification

To configure your ClearQuest client for Windows to receive e-mail notification, edit 
your user profile as follows:

1 Click View > Change User Profile. The User Profile dialog box opens.

2 Type your e-mail address in the E-Mail box.

3 Click OK to save your changes.

Configuring Your ClearQuest Client to Send E-Mail Notification

If your ClearQuest administrator configured a site default e-mail address when 
creating the release area, this e-mail address is configured by default when you install 
the ClearQuest for Windows client software. (For information on configuring site 
default values using the Rational SitePrep Wizard, see the Installation Guide for 
Rational Server Products.)

After installing ClearQuest for Windows, you can enable e-mail notification if a site 
default e-mail address is not defined, or you can change your default e-mail address, 
as follows:

1 Start the E-Mail Options Wizard by clicking View > E-Mail Options. The Choose 
E-Mail Provider dialog box appears.

2 Select the Enable E-Mail notification check box.

3 In the E-Mail Provider list, select either MAPI or SMTP. Then click Next.
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4 If you selected SMTP, the Configure Mail Server dialog box appears. Do the 
following:

a In the Outgoing SMTP Server box, type the SMTP host address of your e-mail 
server. If you do not know this address, ask your ClearQuest or network 
administrator.

b In the Your E-Mail Address box, type the e-mail address from which you will 
send notification when you modify ClearQuest records. For example, this can 
be your e-mail address or that of a group to which you belong. The e-mail 
address must be a valid RFC-822 address. For additional information, ask your 
ClearQuest or network administrator.

c Click Finish to save your changes.

5 If you selected MAPI, the Choose Profile dialog box appears. Do the following:

a In the MAPI Profile list, select a profile. ClearQuest automatically detects any 
existing profiles and displays them in the list. If you have e-mail set up on your 
computer, a profile should already exist for you. If there are no choices in the 
list, contact your ClearQuest or network administrator.

b Click Finish to save your changes.

Note:  MAPI notification does not work without Collaboration Data Objects 
installed. If you have not installed Collaboration Data Objects on the client 
machine, perform the steps in Installing Collaboration Data Objects on page 88.

Installing Collaboration Data Objects

Collaboration Data Objects must be installed in Microsoft Outlook 2000 for 
ClearQuest MAPI notification to work properly. If you have not already installed 
Microsoft Outlook 2000, follow the steps below.

If you have Microsoft Outlook 2000 already installed, follow these steps:

1 From the Start menu select Settings > Control Panel and double-click Add/Remove 
Programs.

2 Select Outlook 2000 (or Office 2000 if that’s how Outlook was installed), and click 
Change.

3 Expand Microsoft Office and click the icon for Collaboration Data Objects.

4 Click Run from my computer from the drop-down list.

5 When you are finished, click Update Now.

If you do not have Microsoft Outlook 2000 installed, follow the recommended 
Microsoft Outlook 2000 installation procedures/guidelines. Be sure to check the 
option to install the Collaboration Data Objects.
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Logging In to ClearQuest Web

To log in to ClearQuest Web for the first time:

1 Ask your administrator for the ClearQuest URL, database name, and the username 
and password that you should use.

2 Start your Web browser, and then type the following URL:

http://<host>/<alias>

where: 

❑ <host> is the host name of the ClearQuest Web server, and

❑ <alias> is the directory containing the ClearQuest Web files.

3 Press RETURN.

4 In the ClearQuest Web Logon page:

a At User Name, Password, and Database, enter the information that your 
administrator gave you.

b Click Logon.

Configuring Your ClearQuest Web Client To Receive E-Mail Notification

After your ClearQuest administrator installs the ClearQuest Web on an IIS Web 
server, you may need to configure your ClearQuest Web client to receive e-mail 
notification. To do so:

1 Click Operations > Change User Profile. The User Profile page opens.

2 Type your e-mail address in the E-Mail box.

3 Click Commit to save your changes.

Using the Advanced Query Editor

The advanced query editor feature for ClearQuest Web requires a Java Runtime (JRE) 
plug-in on the Web user ’s computer. 

Note:  Only users with Query Editor privileges or Super User privileges can access 
this function.

When you access ClearQuest Web on a UNIX or Windows platform using one of the 
supported browsers, ClearQuest Web displays a warning message if a Java plug-in is 
not enabled and then displays a prompt to download the Java plug-in.
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Rational RequisitePro – After Install

After you install RequisitePro and Oracle client, if applicable, on your desktop, you 
then:

� Create an Oracle database alias.

� Can create a RequisitePro project that uses the database for storing RequisitePro 
data, or 

� Can add an existing project to your catalog and open it up. 

To use the RequisitePro Web client, see Logging In to RequisiteWeb on page 93.

Defining Oracle Database Aliases on Each Client

Use the Oracle SQL*Net or Net8 Easy Configuration tool to configure access from 
your client to the Oracle database server. If you plan to share projects with other users, 
be sure to use a consistent database alias or service name, as determined by your 
database administrator.

Creating a RequisitePro Project

Ask your database administrator for the database vendor and follow the instructions 
in this section for that vendor (Creating a Project in Oracle on page 90 or Creating a 
Project in SQL Server on page 92). 

If you have project data in a Microsoft Access database, you can use the Data 
Transport Wizard to convert the data to an Oracle database or SQL Server. See Using 
the Data Transport Wizard for more information.

Using the Data Transport Wizard

To convert a project from an existing Microsoft Access database to an Oracle database 
or to a SQL Server, use the Data Transport Wizard. In Windows Explorer, start the 
Data Transport Wizard. Navigate to the directory:\Program 
Files\Rational\RequisitePro\bin\ and double-click the executable, rqdatatransportwiz.exe.

Creating a Project in Oracle

Perform the following steps to create a RequisitePro project that uses Oracle for the 
project database.

Use the Oracle SQL*Net or Net8 Easy Configuration tool to configure access from 
your client computer to the Oracle database server. If you plan to share projects with 
other users, be sure to use a consistent database alias or service name, as determined 
by your database administrator.
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To configure your access to Oracle from RequisitePro, the database administrator 
must provide the following information:

❑ Oracle database server name (TCP/IP Host Name)

❑ Oracle database alias or service name

❑ Oracle schema name for storing RequisitePro projects (see procedure below)

❑ Your user ID for logging on to the Oracle database

❑ Your user password for logging on to the Oracle database

To create a RequisitePro project in Oracle:

1 In RequisitePro, click File > New > Project. The Create Project dialog box appears.

2 Select a project template.

Note:  The details in the lower part of the dialog box provide an explanation as you 
select each template.

3 Click OK. The Rational RequisitePro Project Properties dialog box appears.

4 Enter a project name and directory location.

5 At the Database field, select Oracle from the drop-down list and click the 
Properties button. The Database Properties dialog box appears.

6 Click the Configure button. The Microsoft ODBC for Oracle Setup dialog box 
appears. 

7 Do not modify the default entries in the Data Source Name and Description 
fields.

8 Type your User Name for logging into the Oracle database, as provided by your 
Oracle database administrator. By default, the user name is "reqpro".

9 For the Server field, type the alias or service name you entered when configuring 
your PC for access to the Oracle database.

Note:  PCs that will access shared RequisitePro projects in the Oracle database 
must have this same database alias or service name.

10 Click OK. The Database Properties dialog box appears.

11 Click the Account Info button. The Database Account Info dialog box appears. 

12 Do not modify the User ID field. This should match the user name you entered in 
the previous dialog box. 

13 Type your user password for logging into the Oracle server. (Your Oracle database 
administrator should have supplied the password.)

14 Retype your password in the Verify Password field.
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15 In the Schema field, type the name of the Oracle schema that your Oracle 
database administrator has established for storing RequisitePro data in Oracle.

16 Click OK to close the Database Account Info dialog box. Click OK to close the 
Database Properties dialog.

17 Finish creating your project, then click OK to close the Project dialog box.

Creating a Project in SQL Server

Perform the following steps to create a RequisitePro project that uses SQL Server for 
the project database.

To configure access to SQL Server from RequisitePro, the database administrator must 
provide you with the following information:

� SQL Server machine name (TCP/IP Host Name)

� SQL Server default database for RequisitePro projects, such as “RequisitePro”

� User ID for logging on to the SQL Server database, such as “ReqPro”

� User password for logging on to the SQL Server database, such as “reqpro”

To create a RequisitePro project in SQL Server:

1 Start RequisitePro. In RequisitePro, click File > New > Project. The Create Project 
dialog box appears.

2 Select a project template.

Note:  The details in the lower part of the dialog box provide an explanation as you 
select each template.

3 Click OK. The Rational RequisitePro Project Properties dialog box appears. 

4 Enter a project name and directory location.

5 At the Database field, select SQL Server from the drop-down list.

6 Click the Properties button. The Database Properties dialog box appears. 

7 On the Database Properties dialog box, click the Configure button. The “Create a 
New Data Source to SQL Server” dialog box appears. 

8 Do not modify the data source Name or Description fields. In the Server field, 
type the name of the SQL Server, supplied by your database administrator.

9 Click Next. The second data source screen appears. 

10 Select the option With SQL Server authentication using a login ID and
password entered by the user.

Note:  RequisitePro does not support Windows NT authentication.
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11 Be sure the check box Connect to SQL Server to obtain default settings for the
additional configuration options is checked.

12 Type the login ID and password supplied by your database administrator, such as 
“ReqPro” and “reqpro.” Click Next.

13 Click the check box Change the default database to and select a database name 
supplied by your database administrator, such as “RequisitePro.” Click Next.

14 Click Next to accept the default language, character, and regional settings. The use 
of log files, shown on the following screen, is optional.

Note:  Do not select the check box Change the language of SQL Server system
messages to... Selecting this check box prevents users from opening the project 
after its initial creation.

15 Click Finish. The ODBC Microsoft SQL Server Setup dialog box appears.

16 Click the Test Data Source button. The SQL Server ODBC Data Source Test dialog 
box appears.

17 Click OK. The ODBC Microsoft SQL Server Setup dialog box appears.

18 Click OK. The Database Properties dialog box appears.

19 On the Database Properties dialog box, click the Account Info button. The 
Database Account Info dialog box appears. 

20 Type the User ID and Password, supplied by your database administrator for 
accessing the SQL Server database, such as “ReqPro” and “reqpro.”

21 Retype your password in the Verify Password field.

22 In the Schema field, type the user name of the owner of the RequisitePro database 
tables, supplied by your database administrator, such as “ReqPro.”

23 Click OK to close the Database Account Info dialog box. Click OK to close the 
Database Properties dialog box.

24 Finish creating your project, then click OK to close the Project dialog box.

Logging In to RequisiteWeb

To log in to RequisiteWeb for the first time:

1 Ask your administrator for the ReqWeb database server name and the username 
and password that you should use.

2 Start your Web browser, and then type the following:

http://<server name>/ReqWeb

where server name is the name of the database server.
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3 Press RETURN.

The RequisiteWeb Logon page appears.

4 In the RequisiteWeb Logon page:

a At Project, select the project from the pull-down menu.

b At User and Password, type the information that your administrator gave you.

c Click Logon.

Installing Additional Testing Software

To complete the setup of your Rational testing environment, you need to install this 
addtional software. See Table 3 for the list.

Installing and Removing the Network Driver

To record sessions over a network for performance testing, install the Rational Test 
network driver. If you have a network driver from a previous version, remove it and 
install the current network driver. The following sections explain how to do this on 
Windows NT, XP, and 2000.

Installing the Network Driver on Windows NT

To install the Rational Test network driver on Windows NT:

1 Install your Rational testing software.

2 Click Start > Settings > Control Panel.

3 Double-click the Network icon.

4 Click the Protocols tab.

Table 3 Installing Additional Testing Software

Done Task

Installing and Removing the Network Driver on page 94.

Installing Rational Test Agents on page 97.

Supported Playback Environments on Agent Computers on page 99.

Accessing Rational ManualTest Web on page 101.

Installing the Sample Applets on page 104.
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5 Click Add.

6 Click Have Disk. The required files were copied to the Rational directory during 
Rational Test installation.

7 Specify one of the following file paths to install the driver.

❑ For Windows NT Ethernet networks, type:

C:\Program Files\Rational\Rational Test\driver

or <installpath>\Rational\Rational Test\driver

where installpath is the drive and path is where you installed the Rational 
testing software.

❑ For Windows NT Token Ring networks, type:

C:\Program Files\Rational\Rational Test\drivertk

or <installpath>\Rational\Rational Test\drivertk

where installpath is the drive and path is where you installed the Rational 
testing software.

Note:  You can install only one type of driver on your computer at a time, either 
Ethernet or Token Ring. Remove one type of driver before installing a new type of 
driver. 

8 Click OK.

9 In the Select OEM Option dialog box, click OK again to verify the driver.

10 Click Close.

11 Click Yes to shut down Windows and restart your computer after you install the 
network driver.

Removing the Network Driver from Windows NT

If you need to switch from an Ethernet network to a Token Ring network, or the 
reverse, remove the driver for the unwanted network type before you install the 
driver for the new network type.

To remove a network driver from Windows NT:

1 Click Start > Settings > Control Panel and double-click the Network icon.

2 Click the Services tab.
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3 Select the Rational network driver from the Network Services list.

❑ If your current driver is from Rational Suite PerformanceStudio 1.0 or earlier, 
select PerformanceStudio Network Driver.

❑ If your current driver is from Rational Suite PerformanceStudio 1.5 or 2000, 
select RSPS Network Driver.

4 Click Remove.

5 Click Yes to confirm that you want to remove the driver.

6 When the removal is complete, click Close.

7 Click Yes to reboot the computer.

When the computer restarts, you can install the new network driver. 

Installing the Network Driver on Windows XP or Windows 2000 

To install the Rational Test network driver on Windows XP or Windows 2000:

1 Click Start > Settings > Network and Dialup Connections.

2 Right-click Local Area Connection, and then select Properties from the context 
menu.

3 Click Install.

4 Click Protocol and click Add.

5 Click Have Disk.

6 Enter the path where the driver is located or browse for the driver. For example, 
type:

C:\Program Files\Rational\Rational Test\driverw2k

or <installpath>\Rational\Rational Test\driverw2k

where installpath is the drive and path where you installed the Rational testing 
software.

7 Select either Ethernet or Token Ring network and click OK.

8 Click Yes to shut down Windows and restart your computer after you install the 
network driver.

Removing the Network Driver from Windows XP or Windows 2000

To remove the network driver from a Windows 2000 or a Windows XP computer:

1 Click Start > Settings > Network and Dialup Connections.

2 Right-click Local Area Connection, and select Properties from the shortcut menu.
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3 Select Rational Test Network Driver 2000 from the Network Services list.

4 Click Uninstall.

5 Click Yes to confirm that you want to remove the driver.

6 When the removal is complete, click Close.

7 Click Yes to reboot the computer.

Installing Rational Test Agents

After you install and license your Rational testing software on a Local computer, you 
have the option of installing Rational Test Agents on other computers. The same 
version of Rational testing software must be installed on the Local and Agent 
computers; otherwise, they do not work together.

Note:  When projects containing GUI or Manual scripts are to be shared, create the 
project in a shared directory using the Uniform Naming Convention (UNC). UNC 
paths are required for GUI test scripts and Manual test scripts that are run on Agent 
computers. For more information about creating a shared directory, see the Rational 
Suite Administrator’s Guide or the Rational Administrator Help.

Installing a Windows Agent

See Installing Rational Products on page 91 for installing the Rational Test Agent on a 
Windows computer. 

Starting a Windows Agent

A Windows Agent runs as an application. To start the Agent, click the executable or 
put it in a start group. 

On Windows NT, you can run the Agent as an NT service if the Agent is only for 
virtual testers. 

To run an Agent as an NT service:

1 Right-click the Start menu. Click Open All Users.

2 Double-click Programs.

3 Double-click Startup. If the Agent is running, exit from it. 

4 Right-click the Rational Test Agent icon and select Delete.

5 If you are running the Local computer as an Agent:

a Click Start > Run.

b Type rtpsvc -install and click OK.
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6 Start the Agent as an NT service:

a Click Start > Settings > Control Panel.

b Double-click Services.

c Select Rational Test Agent Service from the list of services and click Start.

7 To start the Agent automatically when you restart your computer:

a Click Startup.

b Click Automatic in the Startup Type box and click OK.

Installing a UNIX Agent

To install Agent software on a UNIX or Linux computer:

1 Logon to the system as a superuser.

2 Mount the Test Agent CD using the mount command specific to your system. For 
example: 

mount -F hsfs -r /dev/cd0 /cdrom

3 Copy the agent to your machine's temporary directory based on your operating 
system type. For example:

cp /cdrom/solaris_agent.tar.gz /tmp

4 Change directory to the temporary directory.

cd /tmp

5 Unzip the agent tar file using gzip.

gzip -d -n solaris_agent.tar 

6 Make a directory where the agent is to reside.

mkdir /usr/rational 

mkdir /usr/rational/test 

7 Change directory to the agent target directory.

cd /usr/rational/test 

8 Un-tar the agent into the target directory.

tar xvf /tmp/solaris_agent.tar 
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Starting a UNIX Agent

To start a UNIX Agent:

1 Set the RATL_RTHOME environment variable to the target directory.

RATL_RTHOME=/usr/rational/test; export RATL_RTHOME

2 Add the target directory to the PATH.

PATH=$PATH:/usr/rational/test

3 If you are on a Solaris machine only, check the content of the LD_LIBRARY_PATH 
variable (echo $LD_LIBRARY_PATH) and make sure that /usr/openwin/lib is included. 
If it is not, then add it using the following sequence:

LD_LIBRARY_PATH=$LD_LIBRARY_PATH:/usr/openwin/lib 

export LD_LIBRARY_PATH 

4 Change directory to the bin subdirectory under the target directory.

cd /usr/rational/test/bin

5 Start the agent process.

./RTsagt 

Removing a UNIX Agent

To remove the UNIX Agent:

1 Find the rtprvd process and kill it using ps -ef|grep rtprvd.

2 Kill the process:

kill pid

3 rm -rf /usr/rational/test

Supported Playback Environments on Agent Computers

The following table lists the protocols that are supported when you play back a 
performance testing script on an Agent computer. For example, if your Agent 
computer runs Solaris, you cannot play back a test script that accesses ODBC. All 
playback platforms support sockets.

Note:  SQL Server 7.x playback is available on ODBC platforms only.

Also note that use of Agent software on AIX 4.3 requires AIX patch “part number 
ix89833” from IBM. Contact IBM to order the patch.
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* Including ODBC for SQL Server 7 and 2000.

The following table shows the operating systems that are supported when you play 
back a GUI test script on an Agent computer.

Table 4 Agent Platforms for Performance Testing 

Win NT
Win XP
Win 2000

Win ME
Win 98, 
2nd ed.

Sun OS 2.6
Solaris 7
Solaris 8

HP-UX 11
AIX 4.3 DYNIX/ptx 

Red Hat 
Linux 6 & 7

HTTP & 
HTTP/
SSL

Yes No Yes Yes No Yes

Oracle Yes No Yes Yes Yes Yes

Sybase Yes No Yes Yes No No

Tuxedo & 
Jolt

Yes No Yes Yes Yes Yes

SQL 
Server

Yes

No Yes, except 
extended stored 
procedures

Yes, except 
extended stored 
procedures

No No

ODBC* Yes No No No No No

SAP
VU

Yes No No No No No

DCOM/
COM+

Yes No No No No No

CORBA 
(Visibroker 

3.x only)

Yes No Yes No No No

WebLogic
/EJB

Yes Yes No No No Yes

JAVA Yes Yes Yes No No Yes
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Accessing Rational ManualTest Web

After your administrator has installed and configured the ManualTest Web software 
on a Web server, use a Web browser to run a test case with a manual test script 
implementation. 

Setting Up a Web Browser

You can use a Web browser listed in Desktop System and Software Requirements on 
page 27 to run a test case. The Web browser can run on any supported operating 
system.

Netscape Navigator

To set up a Netscape Navigator browser to run a test case:

1 Start Netscape Navigator.

2 Click Edit > Preferences. Under Category, click Advanced.

3 Double-click Advanced, and then click Cache to display the Cache panel.

4 In the Cache panel, click Every time.

5 Click OK.

Microsoft Internet Explorer 

To set up a Microsoft Internet Explorer browser to run a test case:

1 Start Internet Explorer.

2 Do one of the following:

❑ For Internet Explorer 5.0 or later, click Tools > Internet Options. 

❑ For Internet Explorer 4.0, click View > Internet Options.

Table 5 Playback Environments for GUI Testing 

Win NT
Win XP
Win 2000

Win 98, 
2nd ed. Solaris

HP-UX
AIX DYNIX/ptx Linux 

SQA Basic Yes Yes No No No No
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3 Click the General tab.

4 Under Temporary Internet files, click Settings.

5 Under Check for newer versions of stored pages, click Every visit 
to the page.

Accessing ManualTest Web

1 Ask your administrator for the ManualTest Web URL.

2 Start your Web browser, and then type the following:

http://<server name>/<alias>

where the server name is the network name of the Web server, and the alias is the 
directory where you or your administrator installed the ManualTest Web 
Execution software on the Web server. 

To enable others to access your manual test scripts from a Web browser, see About 
Shared Projects.

About Shared Projects

When you create a project, make it a shared project so others can access your manual 
test scripts from a Web browser. To share a project, create the project in a shared 
directory and use the Uniform Naming Convention (UNC) for the directory name.

For example:

\\testweb\commontest\scripts

Note:  UNC paths are required for GUI test scripts that are run on Agent computers.

Troubleshooting 

This section describes some problems (and their solutions) that you may experience 
when running a test case from a Web browser.

Note:  The error messages in this troubleshooting section are ManualTest Web 
Execution error messages, not Web browser error messages.

Problem – Your Rational projects do not appear when you log onto a Rational project. 
(Type http://computername/alias and log onto a Rational project.)
Error message – None.
Solution – All Web clients use the same user account to access a Rational project either 
on a Web server (if the project is on the Web server) or on the domain (to access shared 
projects on other systems in the domain). 

Check the following:
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� Make sure that this user account has administrator privileges to read and write 
into a Rational project. (Ask your administrator to check the privileges of the user 
account that they set up on the Web server.)

� To allow Web clients access, you must also log onto this account when you create a 
new Rational project or register an existing Rational project using the 
Administrator.

Problem – When you log onto a project from a Web browser, you receive an error 
message.
Error message – Unable to connect to project.
Solution – Make sure the Web server privileges are set correctly. Ask your 
administrator to check the Web server privileges For information about setting 
privileges, see Configuring a Microsoft Internet Information Server or Configuring a 
Microsoft Personal Web Server in the Installation Guide for Rational Server Products.

Problem – You get an error message when you select a manual test script.
Error message – Error message that includes Server.ObjectCreate in the 
message.
Solution – Make sure that you or the Web server administrator installs Microsoft 
Internet Explorer 5.0 or later on the Web server.

Problem – When you type text in a dialog box and submit it, you observe erratic 
behavior. Alternatively, when you open a manual test script, results and comments 
are already filled in from the last session. 
Error message – None.
Solution – Disable caching on your Web browser. For information about disabling 
caching, see Setting Up a Web Browser on page 101.

Problem – After you connect to the Web server, a Login dialog box appears. In the 
Login dialog box, the project select list is empty.
Error message – None.
Solution – Create a project and create manual test scripts, or register an existing project 
that contains manual test scripts. 

To create a project or register an existing project:

1 Do one of the following:

❑ For Microsoft Internet Information Server, log onto the user account of the 
virtual directory that your administrator configured to run a test case. For 
information, see Configuring a Microsoft Internet Information Server in the 
Installation Guide for Rational Server Products.

❑ For Microsoft Personal Web Server, log onto the user account that the Web 
server runs under. For information, see Configuring a Microsoft Personal Web 
Server in the Installation Guide for Rational Server Products.
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2 Start the Rational Administrator (installed with RequisitePro, Robot, SQL 
Anywhere, TestFactory, TestManager, and Rational Suite editions) and create a 
new project, or register an existing project. For information about creating or 
registering a project, see the Rational Suite Administrator’s Guide or the Rational 
Administrator online Help.

3 If you create or register a shared project, make sure that the privileges for the 
project directory are set for the virtual directory user account for IIS or for the user 
account that the Web server runs under for PWS.

4 Restart the Web server.

Installing the Sample Applets

The Rational sample applets are included:

� Small sample applets – You can install sample applets for Java, HTML, Oracle 
Forms, PowerBuilder, and Visual basic development environments.

To install the sample applets:

1 Install Robot, Rational TeamTest, TestStudio, or EnterpriseStudio.

Note:  You cannot install the Rational sample applets if your only installed Rational 
testing product is TestManager.

2 Click Start > Programs > Rational Software > Rational <product name> > Rational Test > 
Set Up Rational Test Samples.

3 Select the sample applets that you want to install:

❑ HTML Sample

❑ Java Sample

❑ Visual Basic Sample

❑ PowerBuilder Sample

❑ Oracle Sample

4 Click Next.

5 Click Finish to complete the installation.
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4Removing Rational 
Products
This chapter describes how to remove Rational products from your desktops. To 
remove Rational server products, see the Installation Guide for Rational Server 
Products.

Before You Remove Rational Software

This section provides general requirements for removing Rational desktop products. 
It also describes which components the Rational Setup Wizard does or does not 
remove from the computer.

� If you plan to move the application to another system, first return the license key 
file to your Rational Software account. To return a node-locked or floating license 
key, use Rational AccountLink (www.rational.com/accountlink), the online license 
management tool. For more information about moving licenses or returning 
licenses, see the Rational Software License Management Guide.

� Removing a Rational product does not delete the license key file, project databases, 
and other files that you created while using the product. If you plan to install an 
upgrade of the Rational product to a different drive or use a new installation path, 
back up these files and manually remove them. If you do not remove them, the 
Rational Setup program may find these files and install the application in the old 
location instead of the new location.

� Before removing the Rational products (including the Rational license server) from 
clients, record the specified license serve hostname(s) in the Rational License Key 
Administrator (LKAD). 

a Launch the LKAD from Start > Programs > Rational Software > Rational License 
Key Administrator. 

b Find the hostname(s) in Settings > Client/Server Configuration. 

c After you install the new Rational products, reset the license server name in the 
(LKAD). The LKAD Wizard should launch after the installation. If the Wizard 
does not launch, use Start > Programs > Rational Software > Rational License Key 
Administrator.
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� To remove Rational Software products from a Windows NT, 2000, or XP system, 
you must have Windows administrator privileges on the local system.

� Make sure that no one is using the application or any associated files. You cannot 
remove files that are in use.

Removing Rational Software

Use the Windows Add or Remove Programs control panel to select and remove the 
Rational product. Click Start > Settings > Control Panel > Add or Remove Programs. 
Highlight the product and click Remove.

Removing the RUP Modeler

Use the Windows Add/Remove Programs control panel to remove the software. 
Browse to the location where you installed the RUP Modeler. The default location is 
C:\Program Files\Rational\RUPModeler. If a folder titled RUPModeler still resides in the 
Rational directory, delete the entire folder.
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Index 
A
accessing ManualTest Web 95– 96
AccountLink 24
administrator privileges 26, 61
Agent computers

about 58
installing UNIX Agent 92
installing Windows Agent 91
platforms for GUI testing 95
platforms for performance testing 94
playback platforms 93
removing UNIX Agent 93
starting 91– 93

agreement, license 65
applying service releases 74

B
backing up

registry 62
system directories 62

block, installation 74

C
canceling installation 73
CD-ROM

canceling installation from 73
description of deployment method 61
installing from 38, 64
reinstalling from 73

ClearCase LT
creating views 75
environment variable 42
file storage space 29
installing Internet Explorer 42
integration support 29, 31
license requirements 25
native client installation checklist 41
part of Rational Suite 42

upgrading to ClearCase 40
ClearCase Primary Group 42
ClearCase Web

client installation checklist 42
logging in to 76

ClearQuest
compatibility issues 45
installing collaboration data objects 82
integration support 29, 31
logging in to 81
native client installation checklist 44
receiving e-mail notification 81
sending e-mail notification 81
setting up VS.NET integration 45

ClearQuest databases
connecting to 78
creating DB2 database alias 77
creating new connections 79
creating Oracle database alias 78
importing connection profiles 80
installing DB2 client 46
installing Oracle client 46
using connection profiles 80

ClearQuest Web
client installation checklist 45
compatibility issues 45
logging in to 83
receiving e-mail notification 83
using the advanced query editor 83
Web browsers 46

client installation requirements 27
client software

DCOM/COM+ 60
for performance testing 59
Microsoft SQL Server 59
Oracle 59
SAP 60
Sybase 59
TUXEDO 60
WebLogic/EJB 60

creating views 75
Custom Setup page 62
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D
Data Transport Wizard 84
DCOM/COM+ Protocol software 60
default installation path 62
deployment method

CD-ROM installation 38
enterprise deployment 38
instructions 60
release area 38
silent installation 38

disk space
point product 29
Rational Suite 28
temporary 62

distributed testing 57
documents, accessing 36, 61
download manager 74
dual boot systems 36

E
enterprise deployment 38
environment variable for ClearCase LT 42
error summary 61
Ethernet network 56

installing driver 89
switching to Token Ring 89

H
hardware and software requirements 27

I
installation

block 74
canceling 73
CD-ROMs 61
desktop requirements 27
install.log 61

Microsoft Core Components 62
mixed versions 22
procedures 59
warning 74

installing
Agent computers 58
from CD image 64
from release area 66
mixed versions 22
service releases 74
Test Enablers 61
Test network driver 88

install.log 61

L
language support 37
license agreements 65
License Management Guide 26
license servers

removing 21, 59
specifying 64

licensing
ClearCase LT 25
ClearQuest 25
evaluation floating 24
License Key Administrator 24
ordering keys 26
permanent floating 24
permanent node-locked 24
Rose 25
Testing Products 25
testing products 25
upgrading 26
Web clients 25
Windows Terminal Servers 26

local administrator privileges 26
logging in to

ClearCase Web 76
ClearQuest 81
ClearQuest Web 83
ProjectConsole Web 50
RequisiteWeb 87
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M
ManualTest Web

about 57
accessing Web server 95– 96
setting up Microsoft Internet Explorer 95
setting up Netscape Navigator 95
sharing projects
troubleshooting 96

Microsoft Core Components, installing 62
Microsoft Internet Explorer, setting up 95
Microsoft Windows installer software 73
mixed versions 22
modifying installation 73

N
Netscape Navigator, running test cases 95
network drivers

installing 88
removing 89

network recording 88
networks, switching 89

O
operating system support 27
Oracle clients

configuring 84
for performance testing 59

ordering license keys 26

P
patches. See service releases. 74
performance testing 59
playback platforms 93
privileges, administrator 26
procedures, installing Rational products 59
ProjectConsole

client installation checklist 49
client screen area setting 50
enabling cookies 50
installing Template Builder 49
integration support 29
logging in to 50

projects, shared 96
PureCoverage

integration support 30
requirements 22

Purify
integration support 30
requirements 22

PurifyPlus
integration support 30
requirements 22

Q
Quality Architect, about 58
Quantify

integration support 30
requirements 22

R
Rational Download Manager 74
Rational Process Workbench

installation procedure 48
removing RUP Modeler 102
RUP Modeler 48
RUP Organizer 48

Rational products, removing 21, 59
Rational Setup Wizard

canceling installation from CD image 73
custom setup page 62
default installation path 62
deployment types 37
installation procedures 59
installing from CD image 64
reinstalling from CD image 73
requirements 61
specifying the license server 64
stopping services 61

Rational Suite
installation checklist 39
preparing to install 38

Rational Unified Process 23
Rational Unified Process Modeler 48
Rational Unified Process Organizer 48
reinstalling from CD 73
Index 109



rs_install_desktop.book  Page 110  Wednesday, April 16, 2003  4:52 PM
release area
customizing client configuration 68
description of deployment method 38
using standard configuration 66

remote access support 28
removing software

administrator privileges 102
command line 71
databases 101
different drives 101
files 101
installation path 101
license keys 101
license server 21, 59
network drivers 89
previous versions of Rational software 21, 59
Rational Unified Process Modeler 102
requirements 101

repair installation 73
requesting license keys 26
requirements and recommendations 27
RequisitePro

creating a project in Oracle 84
creating a project in SQL Server 86
defining alias on client 84
integration support 30
logging in to. See Creating a Project in Oracle 

or SQL Server. 84
native client installation checklist 52
preparing to install 51
using Data Transport Wizard 84

RequisiteWeb
client installation checklist 53
cookies 53
logging in to 87

Robot
about 57
for distributed testing 57

Robot, integration support 30
Rose

adding to user path 54
installation checklist 54
installing multiple variants 53
integration support 30, 32
licensing 25
preparing to install 53

Rose Data Modeler 33

Rose RealTime 21, 33

S
SAP Protocol software 60
service releases 74
sharing projects 96
silent installation

description of 38, 69
performing 70
removing product 71

SoDA integration support 30
specifying license server 64
SQA Suite 6.x

installing Robot 55
installing TeamTest 55

SQL Server client software for performance test-
ing 59

Sybase client software for performance testing 59
system and software requirements 27

T
TeamTest, about 58
temporary disk space 62
Test Agents

about 58
installing client software 59
integration support 34
removing UNIX Agent 93
starting 91– 93
supported playback platforms 93
UNIX operating systems 34
Windows operating systems 34

Test Datastores, about 58
Test Enablers

about 60
ActiveX Test Control 60
installing 61
Test Delphi Enabler 61
Test Java Enabler 60
Test Oracle Forms Enabler 61
Test Visual Basic Enabler 61

Test network driver, installing 88
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Testing Products
installation checklist 55
installing network drivers 88
license requirements 25
ManualTest Web Execution 57
QualityArchitect 58
Robot 57
TeamTest 58
Test Agents 58, 91
Test Datastores 58
Test Enablers 60
TestManager 56
XDE Tester 61

TestManager
about 56
integration support 30

Token Ring network 56
installing driver 89
switching to Ethernet 89

troubleshooting manual test scripts 96
TUXEDO Protocol software 60

U
unattended installations. See silent installation.
UNC, using for directory names 96
Uniform Naming Convention. See UNC.
UNIX Agent

installing 92
removing 93
starting 93

upgrading
licenses 26

Rational products 21
user interface manager, shutting down 62

V
views, creating 75
virus protection software 61

W
warning, installation 74
Web browsers

non-Windows requirements 36
setting up Microsoft Internet Explorer 95
setting up Netscape Navigator 95
Windows requirements 35

WebLogic/EJB Protocol software 60
Windows Agent

installing 91
starting 91

X
XDE

integration support for 33
XDE Developer 61
XDE Modeler 61
XDE Tester

about 61
integration support for 33
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